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1 Introduction

Westlaw Case Notebook is an electronic organizer and deposition tool for saving and working with 
important documents, research, and transcripts. With Case Notebook you can

• track key facts and their related issues

• track the parties involved in the litigation

• import and convert key documents to text-searchable formats using optical character recognition 
(OCR) technology

• send research documents from Westlaw or WestlawNext to a case file

• check KeyCite status

• create outlines and transcript summaries

• build issues databases by creating categories and highlighting text

• summarize issues by running reports

• copy text from a Westlaw or WestlawNext document and paste the text along with the citation into 
a word-processing document

• connect to a deposition transcript in real time

File Types for Importing Transcripts
You can import the following types of transcript files into Case Notebook:

• E-Transcript files (PTX or EXE)—transcript only format provided by court reporters; may include 
court reporter’s signature

• ASCII (text only) files—transcript only format

• Portable Transcript (PTF) files—used to move a transcript with annotations to another program 
that will accept that file type or another Case Notebook computer

• LiveNote Evidence Format™ (LEF™) files—contain the transcript with linked exhibit files; may 
contain synchronized video

• Publisher Bundle (bundle.xml) files—contain the transcript with linked exhibit files; may contain 
synchronized video

• E-Transcript Bundle (PTZ) files—created with West Publisher version 5 or later; contain the 
transcript with linked exhibit files; may contain synchronized video

• Extensible Markup Language (XML) files—contain the transcript with linked exhibit files; may 
contain synchronized video

• CT Summation (TRN) files

• Timaro Technologies Post-Production Time-Stamp (PTS) files 
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File Types for Importing Documents and Pleadings
You can import the following types of files for documents and pleadings into Case Notebook:

An administrator can designate who can access the case file documents. 

Getting Help
Online Help is available in Case Notebook to assist you. Simply click Contents on the Help menu. 

You can also easily access free online lessons and webinars to help you learn Case Notebook. On the 
Help menu, click Online Lessons to display the West eLearning Center page. 

•  Images

• TIF/TIFF (Tagged Image File Format)

• BMP (Bitmap)

• JPE/JPG/JPEG (Joint Photographic 
Experts Group)

• GIF (Graphic Interchange Format)

• PNG (Portable Network Graphics)

• JFX

• PDF (Portable Document Format)

• DOC/DOCX (Microsoft Word file)

• WP/WPD (Corel WordPerfect file)

• MSG (Microsoft Outlook file)

• HTM/HTML (Hypertext Markup Language)

• PEX (LiveNote document file)

• TXT (plain text file)

• RTF (Rich Text Format)

• Document review load files

• CaseCentral ASCII Load File (TXT)

• Concordance ASCII Load File (DAT)

• IPRO ASCII Load File (LFP)

• Lextranet ASCII Load File (TXT)

• Opticon ASCII Load File (OPT)

• Summation ASCII Load File (TXT)

Note If your load file is not one of the types 
listed, you still may be able to import 
it using the Custom options or by 
using conversion tools available for 
free on the Internet.
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2 Managing Cases 

Creating a New Local Case 
Cases in Case Notebook can be created for one person to use (local cases), or they can be created 
through the Westlaw Case Notebook Administration module to be available on a network so they can 
be shared (secure cases). Local cases can be imported through the Westlaw Case Notebook 
Administration module to also make them shareable. For further information on Westlaw Case 
Notebook Administration, download a free copy of the Westlaw Case Notebook Administration User 
Guide at store.westlaw.com/support/user-guide/livenote-case-notebook.aspx.

To create a new case, follow these steps: 

1. Access Case Notebook to display the Open Case dialog box (Figure 2-1). 

Figure 2-1. Open Case dialog box

2. Click New to display the Save As dialog box. 

3. Click the location to use for storage of the case; type the file name, e.g., smithvjones; and click 
Save. The New Case Properties dialog box is displayed. 

4. In the Name box, type the name of the case, e.g., Smith v Jones.

5. Click OK. 
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The case window, which lists all the documents for the case, is displayed (Figure 2-2). 

Figure 2-2. Case window

CREATING A NEW CASE FROM AN OPEN CASE
To create a new case from an open case, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Case on the menu. The Save As dialog 
box is displayed. 

2. Click the location to use for storage of the case; type the file name, e.g., smithvjones; and click 
Save. The New Case Properties dialog box is displayed. 

3. In the Name box, type the name of the case, e.g., Smith v Jones.

4. Click OK. 

Opening a Local Case
To open a case, on the File menu, click Open Case to display the Open Case dialog box. Click your case 
in the list and click OK. 

Importing a Case
To import a case, complete these steps:

1. Click the New arrow, then click Case (from File) on the menu. The Open dialog box is displayed.

2. Click your case and click Open. The Save As dialog box is displayed. 

3. In the File name box, type a file name.

4.  Click Save. The message Would you like to add the new case to your case list? is displayed. Click 
Yes. The case is displayed in the case window. 

Opening a RealLegal Binder Case
You can open a RealLegal Binder case, version 5 or later, in Case Notebook. To open a RealLegal Binder 
case, complete these steps:

1. On the File menu, click Open Case to display the Open Case dialog box.

2. Click Add. The Open dialog box is displayed. 

3. Click the RealLegal Binder Case (PXL) file you want to import and click Open.

Main Menu 
toolbar
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4. The message This case was created with RealLegal Binder. It must be imported before it can be 
used. Do you want to continue? is displayed. Click Yes. The Save As dialog box is displayed.

5. In the File name box, type a file name and click Save. The case is listed in the Open Case dialog 
box.

6. Click the case and click OK.

Note The RealLegal Binder case opens as a local case with no assigned users. For further information 
on the conversion of RealLegal Binder cases to Case Notebook cases, see Appendix B.

Accessing Secure Cases 
Note

• If you are working on a secure case with other users, all users must use the same version of Case 
Notebook. For example, if a secure case is upgraded to Case Notebook 3.0, all users working on the case 
must use Case Notebook 3.0.

• If you are working in a Case Notebook 3.0 case, then revert to using Case Notebook 1.0, you must 
manually rebuild the search index for the case. To rebuild the search index, on the Tools menu, 
click Advanced, then click Rebuild Search Index.

To access a secure case, complete these steps:

1. Access Case Notebook. Or in an open case, on the File menu, click Open Case. The Open Case 
dialog box is displayed (Figure 2-3).

Figure 2-3. Open Case dialog box

2. Click Repositories. The Repositories dialog box is displayed (Figure 2-4).

Figure 2-4. Repositories dialog box
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3. Click the repository that you want to log on to and click Logon. The Logon to [Repository Name] 
dialog box is displayed (Figure 2-5). 

Figure 2-5. Logon to [Repository Name] dialog box

4. In the Username and Password boxes, type your username and the password that is assigned to 
you in Westlaw Case Notebook Administration. 

5. Select the Remember my logon settings check box if you want Case Notebook to remember your 
username and password.

6. Click OK. The Repositories dialog box is redisplayed (Figure 2-6).

Figure 2-6. Repositories dialog box

7. Click Close. The Open Case dialog box is redisplayed with a list of the cases to which you are 
assigned (Figure 2-7).

 
Figure 2-7. Open Case dialog box

Note Two types of case icons may be displayed: 

• A brown case icon ( ) indicates a local case or a secure case that is currently being accessed 
through the network. 

• A brown and blue case icon ( ) indicates a secure case that was replicated offline and is 
currently being accessed locally. 
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To view only secure cases, click List Cases by Repository in the list at the top of the dialog box, then 
click the plus symbol (+) next to the repository containing the cases you want to view. 

8. Click your case and click OK. 

ACCESSING SECURE CASES THROUGH WESTLAW CASE NOTEBOOK RAS
Westlaw Case Notebook RAS (remote access server) provides remote access to your Case Notebook 
cases via the Internet. When you access a case remotely, most of the features in Case Notebook are 
available. When you finish working on a case, your changes are saved to the server. After you close a 
remote case, you must log on to another remote session to access the case again. 

When you use RAS, you cannot:

• copy a case

• administer remote cases using Westlaw Case Notebook Administration

• connect to LiveNote Realtime

Note To connect to LiveNote Realtime in a case you access through RAS, you must replicate the 
case offline.

To access a secure case through RAS, complete steps 1 through 8 above.

Viewing a List of Favorite Secure Cases
When you access secure cases in Case Notebook, all of the cases to which you are assigned are listed in 
the Open Case dialog box. You can add one or more of these cases to your list of favorite cases, then 
view only those cases when you access Case Notebook. 

To view your list of favorite cases, complete these steps:

1. Access secure cases. The Open Case dialog box is displayed with the list of the cases to which you 
are assigned (Figure 2-8). 

 
Figure 2-8. Open Case dialog box

2. Right-click the case you want to add to your list of favorite cases, e.g., Clelland v Anderson, and 
click Add to My Favorite Cases.
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3. Click List My Favorite Cases in the list at the top of the dialog box. Your list of favorite cases is 
displayed (Figure 2-9).

Figure 2-9. List of favorite cases

Replicating Cases Offline and to the Network
Note If you replicate a case offline on one computer and want to access the case via the network on a 

different computer, you must have a separate username assigned to you in the repository for 
each computer.

REPLICATING A CASE OFFLINE
You can work on a secure case off the network by replicating the case offline in Case Notebook. To 
replicate a secure case that you are currently working on offline, complete these steps:

1. On the File menu, click Replicate Case Offline. The Case Data dialog box is displayed 
(Figure 2-10).

Figure 2-10. Case Data dialog box

2. Select the document type and data you want to replicate offline. 

3. Click Groups to add the data you selected to a data group. The Data Groups dialog box is 
displayed. Select the group to which you want to add the data and click OK.
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Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.

4. Click Finish. The Cases Replicated to Offline dialog box is displayed, informing you that the case 
was successfully replicated offline. 

5. Click one of the following:

• Open Case. The case is displayed in the left pane.

• Close. The case is closed.

REPLICATING A CASE TO THE NETWORK
To replicate a case you are currently working on to the network, complete these steps:

1. On the File menu, click Replicate Case Online. The Cases Replicated to Network dialog box is 
displayed.

2. Click one of the following:

• Open Case. The case is displayed in the left pane.

• Close. The case is closed. 

REPLICATING MULTIPLE CASES OFFLINE
To replicate multiple cases offline, you must first change your replication options, then close Case 
Notebook and select the cases you want to replicate offline. To replicate multiple cases offline, 
complete these steps:

1. Click Options on the Tools menu. The Options dialog box is displayed.

2. On the Confirmation tab, select the Replicate offline on closing Westlaw Case Notebook check 
box, then click OK.

3. Close Case Notebook. The Cases dialog box is displayed (Figure 2-11).

Figure 2-11. Cases dialog box 

4. Select the cases you want to replicate offline.

5. Click Next. The Case Data dialog box for the first case you selected is displayed. 
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6. Select the document types and data you want to replicate offline.

7. Click Groups to add the data you selected to a data group. The Data Groups dialog box is 
displayed. Select the group to which you want to add the data and click OK.

Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.

8. Click Next. If you selected more than one case, the Case Data dialog box for the next case you 
selected is displayed.

9. Repeat steps 6–8 for each case you want to replicate offline.

10. When you have finished selecting the document types for all the cases you want to replicate offline, 
click Finish. The Cases Replicated to Offline dialog box is displayed, informing you that the cases 
were successfully replicated offline.

11. Click Close. Case Notebook is closed.

REPLICATING MULTIPLE CASES TO THE NETWORK
1. If you replicated cases offline, the next time you access Case Notebook, the Offline Cases dialog 

box is displayed (Figure 2-12).

Figure 2-12. Offline Cases dialog box

2. By default, all the cases that you replicated offline are selected. To exclude a case from being 
replicated to the network, clear its check box.

3. Click Finish. The Cases Replicated to Network dialog box is displayed.

4. Select a case, then click one of the following:

• Open Case. The case is displayed in the left pane.

• Close. The case is closed. 

Changing Replication Options
Case Notebook has replication options that prompt you to replicate the case offline when you close 
Case Notebook or replicate the case to the network when you open Case Notebook. To change these 
options, complete these steps:
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1. On the Tools menu, click Options. The Options dialog box is displayed (Figure 2-13).

Figure 2-13. Options dialog box

2. Select the Replicate offline on closing Westlaw Case Notebook check box, if desired.

3. Clear the Replicate to the network on opening Westlaw Case Notebook check box, if desired.

4. Make your selection the default, if desired.

5. Click OK. 

Viewing Case Contents
You can view a summary of your case contents in the Case Properties dialog box, shown outlined in 
Figure 2-14. To access the Case Properties dialog box, on the File menu, click Case Properties.

While viewing the dialog box, you can copy the summary data and paste it into another application. To 
copy the summary data, right-click at the top of the dialog box and click Copy Summary Data on the 
menu.

Figure 2-14. Case Properties dialog box
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Creating a Case Report
This report includes the names of documents and any comments about the documents. To create a 
Case report, complete these steps:

1. On the Main Menu toolbar, click the Report button ( ), then click Case on the menu. The 
Case Report Properties dialog box is displayed (Figure 2-15). By default, all document types and 
data are selected. To exclude a document type from the report, clear its check box. To exclude 
particular data from the report, click the document type containing the data, then clear the check 
boxes for the data you want to exclude.

Figure 2-15. Case Report Properties dialog box 

2. Click Groups to include only the data in a data group in your report. Select the group you want to 
include in your report and click OK. For further information on data groups, see ”Working with Data 
Groups” on page 104.

3. Click the Display tab to view a list of display options. In the Title box, type a title for the report, if 
desired. Then select or clear the appropriate check boxes.

4. Clear the Include cover page when printing or saving check box, if desired.

5. Click OK. The Case report is listed under Report in the left pane and the text of the report is 
displayed on the Report tab in the right pane.
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3 Managing Transcripts 

Importing a Transcript
To import a transcript, complete these steps: 

1. On the Main Menu toolbar, click the New arrow, then click Transcript (from File) on the menu. The 
Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. In the Files of type list, click a file type. Then click your transcript and click Open. The Transcript 
File dialog box is redisplayed. 

4. Click Next. A message warning that the transcript has not been signed electronically may be 
displayed. Click Continue. The Transcript Properties dialog box is displayed (Figure 3-1). 

Figure 3-1. Transcript Properties dialog box

5. In the Doc-Level Notes box, type a note, if desired. The note will be displayed in the transcript’s 
Annotations folder in the left pane and on the Overview and Doc-Level Notes tabs in the Transcript 
Properties dialog box. Additionally, you can include the note text in a search. For further 
information, see ”Adding Doc-Level Notes” on page 83.

6. Click Groups to add the transcript to a data group. The Data Groups dialog box is displayed. Select 
the group to which you want to add the data and click OK. The Transcript Properties dialog box is 
redisplayed.

Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.
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7. Click Finish. The Import Summary dialog box is displayed. To import another transcript, click 
Again. If you do not want to import another transcript, click Close. The transcript is listed under 
Transcripts in the left pane and the text of the transcript is displayed in the right pane (Figure 3-2).

Figure 3-2. Imported transcript

Note If you see  next to the transcript, the transcript has been signed.

Case Notebook automatically adds characters in the transcript to the list of characters in the case. If 
characters are added when you import the transcript, the Characters tab is also displayed after you 
import the transcript.

Opening an Existing Transcript 
To open a transcript, complete these steps:

1. If necessary, click Transcripts in the left pane to display a list of all transcripts in the case.

2. Double-click the transcript you want to open. The text of the transcript is displayed in the right 
pane.

Creating a Transcript Summary
The Transcript Summary feature allows you to summarize portions of a transcript and create a report of 
the transcript summary items. To create a transcript summary, complete these steps:

1. Open the transcript you want to summarize.
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2. On the Main Menu toolbar, click the New arrow, then click Transcript Summary on the menu. The 
Summary Item section is displayed below the transcript in the right pane, shown outlined in 
Figure 3-3.

Figure 3-3. Summary Item section

3. The arrows in the left margin of the transcript designate the start and end positions of the 
transcript summary item. By default, page 1, line 1 is the start position and page 1, line 2 is the end 
position of the first summary item. 

To change the start position, 

• in the Start Position box, type a new page and line number, e.g., 13:25

• click the arrow next to the Start Position box and click a page and line number in the list

 To change the end position,

• in the End Position box, type a new page and line number, e.g., 15:9

• click the arrow next to the End Position box and click a page and line number in the list

• click a page and line number in the left margin of the transcript

Note You can set start and end positions only for portions of the transcript that you have not 
summarized previously.

4. In the Subject box, type a name for the transcript summary item, e.g., Current employment, if 
desired.

5. Under Subject, type a summary of the portion of the transcript you selected, if desired.

Note You can also copy transcript text and paste it in the summary item, if desired.

6. To check the spelling in a summary item, click the Spellcheck button ( ) on the toolbar.

7. To create a new transcript summary item, click the New Summary Item button ( ) on the toolbar.

8. To view consecutive summary items, click the Previous Item button ( ) or the Next Item button ( ) 
on the toolbar.

9. To close the Summary Item section, click the Close button ( ).
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All summary items are saved automatically when you click the New Summary Item button or close the 
Summary Item section. They are listed in the Summary Items folder under the transcript in the left 
pane. 

Note Once you save a summary item, you cannot change its page and line numbers.

CREATING A TRANSCRIPT SUMMARY REPORT
The Transcript Summary report lists the page and line numbers, the subject, and the text of all 
transcript summary items. To create a Transcript Summary report, complete these steps:

1. Click the Transcript Summary Report button ( ) on the toolbar in the 

Summary Item section. Or on the Main Menu toolbar, click the Report button ( ), then click 
Transcript Summaries on the menu. The Transcript Summary Report Properties dialog box is 
displayed.

2. All of the transcripts in the case are selected on the Data tab by default. To remove a transcript 
from the report, clear its check box.

3. Click Groups to include the data in a data group in your outline. The Data Groups dialog box is 
displayed. Click the group you want to include in the report and click OK. The Transcript Summary 
Report Properties dialog box is redisplayed. 

4. Click the Display tab to view a list of display options. In the Title box, type a title for the report, if 
desired. Then select or clear the appropriate check boxes.

5. Click OK. The Transcript Summary report is listed under Report in the left pane and the text of the 
report is displayed on the Report tab in the right pane (Figure 3-3).

Figure 3-4. Transcript Summary report

When viewing the report, you can

• click the Hit arrows in the left pane to view the next or previous summary in the report. 

• click the Sort by arrow in the left pane to sort your report.

Saving a Transcript Summary Report

To save a transcript summary report, complete these steps:

1. Click Save As on the toolbar above the report in the right pane. The Save As dialog box is 
displayed.

2. Click a location for the file.

3. In the File name box, type a file name.
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4. In the Save as type list, click a file type.

5. Click Save.

Printing a Transcript Summary Report

To print a transcript summary report, click Print on the toolbar above the report in the right pane to 
display the Print dialog box. Then click Print.

OPENING A TRANSCRIPT SUMMARY ITEM
1. If necessary, click Transcripts in the left pane to display a list of all transcripts in the case.

2. Double-click the transcript containing the summary item you want to open. The text of the 
transcript is displayed in the right pane.

3. Double-click the Summary Items folder under the transcript in the left pane to view a list of 
summary items.

4. Double-click the summary item you want to open. The item is displayed in the Summary Item 
section below the transcript in the right pane.

DELETING A TRANSCRIPT SUMMARY ITEM
To delete a summary item, right-click the summary item in the left pane and click Delete. The message 
Permanently delete the selected summary item? is displayed. Click Yes.

Closing a Transcript
To close a transcript so that it is no longer displayed in the right pane, click the Close button ( ) on the 
transcript’s tab.

Deleting a Transcript 
To delete a transcript, right-click the transcript in the left pane and click Delete on the menu. The 
message Permanently delete the selected Transcript and all associated Annotations? is displayed. Click 
Yes.

Printing a Transcript with Annotations
You can display annotations, Quick Marks, and Issue Marks in printed transcripts. For condensed 
transcripts, you can also print annotations, including notes and author information, in the footer of the 
document. To print a transcript with annotations in the footer of the document, complete these steps:

1. Open the transcript you want to print.

2. Click the Print arrow on the toolbar above the transcript and click Print Preview Condensed on the 
menu. The Print Preview dialog box is displayed.

3. Click the Properties icon ( ) to display the Page Setup–Condensed Transcript dialog box.
Managing Transcripts      17



4. Click the Annotations tab (Figure 3-5).

Figure 3-5. Page Setup–Condensed Transcript dialog box–Annotations tab

5. Select the Display Annotations check box, if necessary. 

6. To include or exclude annotations associated with specific issues from the printed transcript, click 
Select Issues. The Select Issues dialog box is displayed. Issues will be listed in this dialog box only 
if they have previously been created. See ”Working with Issues” on page 86.

7. Select or clear the check boxes next to the issues you want to include or exclude and click OK. The 
Page Setup–Condensed Transcript dialog box is redisplayed.

8. Select the Include Quick Marks check box, if desired.

9. Select the Include Annotations with no Issues check box, if desired.

10. Select the Display Annotations in footer check box.

11. In the Display list, click the option for how you want the annotations displayed in the transcript 
text.
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12. Click OK. The transcript with its annotations is displayed (Figure 3-6). 

Figure 3-6. Preview of transcript with annotations

Note Overlapping annotations are highlighted in gray. The Annotation Range is available in the 
footer to help you determine the length of the overlapping annotations.

13. Click the Print icon to print the transcript.

Printing Headers and Footers in Transcripts
You can add a header and footer to each page of a printed transcript, which can help you view transcript 
information when printing selected pages. For example, to add a header, complete these steps: 

1. Open the transcript you want to print.

2. Click the Print arrow on the toolbar above the transcript and click either Print Preview Full-Sized 
or Print Preview Condensed on the menu. The Print Preview dialog box is displayed.

3. Click the Properties icon ( ) to display the Page Setup dialog box.
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4. Click the Page tab (Figure 3-7).

Figure 3-7. Page setup dialog box–Page tab

5. Select the Print header and footer check box.

6. Click a different font and size in the Font and Size lists and select the Bold check box, if desired.

7. Click Edit Text. The Header and Footer dialog box is displayed.

8. Click Header 1. The Top Header Line dialog box is displayed (Figure 3-8).

Figure 3-8. Top Header Line dialog box

9. Type your information in the boxes. To add field data to a box, e.g., case matter information, click 
Insert Field and click a field in the menu (Figure 3-8).

10. Click OK. The Header and Footer dialog box is redisplayed.

11. Click Close. The Page Setup dialog box is redisplayed. 
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12. Click OK. The transcript with the header is displayed (Figure 3-9).

Figure 3-9. Preview of transcript with header

13. Click the Print icon to print the transcript.

Printing Exhibits Linked to Transcripts
The Batch Print feature allows you to print multiple documents at one time, including exhibits that are 
linked to transcripts. To print exhibits that are linked to transcripts, complete these steps:

1. On the File menu, click Batch Print. The Items to Print dialog box is displayed (Figure 3-10).

Figure 3-10. Items to Print dialog box

2. Click Transcripts in the left pane, then select the check box for the transcript you want to print with 
its exhibits in the right pane.

3. Select the Print Exhibits linked to Transcripts check box.

4. Click Print.

Viewing Transcript Properties
To view the properties for a transcript, right-click the transcript name in the left pane and click 
Properties on the menu. For further information on properties, see ”Working with Properties” on page 
79.
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4 Updating Transcripts 

Case Notebook transcripts can be updated using the following types of files: 

• E-Transcript (PTX or EXE) files—files containing transcript text and, if the transcript is signed, the 
signature details

• ASCII (text only) files—files containing transcript text, usually received from the court reporter 

• Portable Transcript (PTF) files—files containing transcript text and annotations, usually received 
from another Case Notebook user 

• LiveNote Evidence Format (LEF) files—files containing transcripts, exhibits, exhibit links, and 
possibly synchronized video 

Note You can also import CT Summation (TRN) files and Timaro Technologies Post-Production Time-
Stamp (PTS) files. 

Any annotations, including Quick Marks and Issue Marks, are automatically transferred to the updated 
transcript. No work product will be lost because all annotations are linked to the transcript text, not to 
the page and line references. Therefore, annotations made in the old transcript are simply transferred 
to the same text location in the updated transcript. 

Starting the Updating Process
To update an transcript, you must first assign draft status to the transcript. To assign draft status to a 
transcript, complete these steps:

1. Click the Transcript Properties button ( ) on the toolbar above a transcript to display the 
Transcript Properties dialog box. 

2. In the Status list, click Draft.

3. Click OK. 

Updating with a PTX or EXE File
1. Click the Update Transcript button ( ) on the toolbar above a transcript. The Update 

Transcript–Transcript File dialog box is displayed.

2. Click Browse to display the Browse for Transcript Files dialog box.

3. Select the PTX or EXE file that was sent to you and click Open. The Update Transcript–Transcript 
File dialog box is redisplayed. 

4. Click Next. A message warning that the transcript has not been signed electronically may be 
displayed. Click Continue. The Update Transcript–Transcript Properties dialog box is displayed.

5. Click Finish. The Update Transcript–Update Completed dialog box is displayed.

6. Click Close. 

Updating with an ASCII File 
1. Click the Update Transcript button ( ) on the toolbar above a transcript in the right 

pane. The Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 
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3. Select the ASCII file that was sent to you and click Open. (Different Computer-Aided Transcription 
(CAT) systems create different extensions on ASCII files.) The Update Transcript–Transcript File 
dialog box is redisplayed. 

4. Click Next. A message warning that the transcript has not been signed electronically may be 
displayed. Click Continue. The Update Transcript–Import Details dialog box is displayed.

5. Click Next. The Update Transcript–Import Confirm dialog box is displayed. 

6. Click Next. The Update Transcript–Transcript Properties dialog box is displayed.

7. Click Finish. The Update Transcript–Update Completed dialog box is displayed.

8. Click Close.

Updating with a PTF File 
Use this method when you want to merge two sets of annotations into one transcript when replication is 
not available. 

1. Click the Update Transcript button ( ) on the toolbar above a transcript in the right 
pane. The Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the PTF file and click Open. The Update Transcript–Transcript File dialog box is displayed.

4. The Replace existing text with new text check box is automatically selected. If there are no changes 
to the text and you want to only merge annotations, clear the check box. 

5. The Import Annotations check box is automatically selected. If you want to only replace text and 
not merge annotations, clear the check box.

6. Under Import Annotations, Add to existing annotations is automatically selected. This is the 
correct selection for merging annotations. Select Replace existing Annotations if you want to 
replace one set of annotations with another set.

7. Click Next. A message warning that the transcript has not been signed electronically may be 
displayed. Click Continue. The Update Transcript–Transcript Properties dialog box is displayed. 

8. Click Finish. The Update Transcript–Update Completed dialog box is displayed.

9. Click Close. 

Updating with a LEF File 
LEF files may contain the transcript with exhibit files and links to exhibit references in the transcript, the 
transcript with exhibit files and links to exhibit references in the transcript and synchronized video, or 
the transcript with synchronized video but no exhibits or exhibit links. 

1. Click the Update Transcript button ( ) on the toolbar above a transcript in the right 
pane. The Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the LEF file and click Open. The Update Transcript–Transcript File dialog box is redisplayed. 

4. The Replace existing text with new text check box is automatically selected. If there are no changes 
to the transcript text, clear the check box. 

5. The Import exhibits check box is automatically selected. If you do not want to import exhibits, clear 
the check box. 

6. The Import Annotations check box is automatically selected. If you do not want to import 
annotations, clear the check box.
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7. Under Import Annotations, Add to existing Annotations is automatically selected. This is the 
correct selection for merging the annotations. Select Replace existing Annotations if you want to 
replace one set of annotations with another set.

8. Click Next. A message warning that the transcript has not been signed electronically may be 
displayed. Click Continue. The Update Transcript–Transcript Properties dialog box is displayed. 

9. Click Finish. The Update Transcript–Update Completed dialog box is displayed.

10. Click Close.
24      Updating Transcripts



5 Managing Documents

You can add key documents to Case Notebook to quickly categorize and search.

Importing a Document
To import a document, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Document (from File) on the menu. The 
Document Files dialog box is displayed. 

2. Click Add to display the Open dialog box. 

3. Click your document and click Open. The Document Files dialog box is redisplayed. 

4. Click Groups to add the document to a data group. The Data Groups dialog box is displayed. Click 
the group to which you want to add the data and click OK. The Document Properties dialog box is 
redisplayed. 

Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.

5. Click Next. The Document Properties dialog box is displayed (Figure 5-1). 

Figure 5-1. Document Properties dialog box

6. By default, the title of the document is entered for you in the Title box. Type a different name for 
the document if desired.

7. In the Type list, click a document type, if desired.

8. In the Author box, type a name or click the name in the list, if desired.

9. In the Recipient box, type a name or click the name in the list, if desired.

10. In the Bates range and Through boxes, type a number, if desired. 

11. Select the Document Date check box, if desired. When you select this check box, the current day’s 
date is entered in the box automatically. Click the arrow to display a calendar and click a different 
date, if desired.
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12. The OCR check box is automatically selected if the document is an image file or PDF file.

13. In the Doc-Level Notes box, type a note, if desired. The note will be displayed in the document’s 
Annotations folder in the left pane and on the Overview and Doc-Level Notes tabs in the 
Document Properties dialog box. Additionally, you can include the note text in a search. For further 
information, see ”Adding Doc-Level Notes” on page 83.

14. Click Finish. The Import Completed dialog box with a list of the documents that you imported is 
displayed.

Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

15. Click OK. The document is listed under Documents in the left pane and the text of the document is 
displayed in the right pane (Figure 5-2). 

Figure 5-2. Imported document

Importing Multiple Documents
To import multiple documents, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Document (from File) on the menu. The 
Document Files dialog box is displayed. 
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2. Click Add to display the Open dialog box (Figure 5-3). 

Figure 5-3. Open dialog box

3. Click your documents and click Open. The Document Files dialog box is redisplayed (Figure 5-4). 

Figure 5-4. Document Files dialog box

Note For most file types, each file is imported as a separate document. For image files, you have the 
option of importing each file as a separate document or merging multiple files into one 
document. To merge multiple image files, make sure the Batch Import, each file is separate 
document check box is clear. To import each file as a separate document, select the check box.

4. Click Groups to add the documents to a data group. The Data Groups dialog box is displayed. 
Select the group to which you want to add the data and click OK. The Document Properties dialog 
box is redisplayed. 

Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.

5. Click Finish. The Import Completed dialog box with a list of the documents that you imported is 
displayed.
Managing Documents      27



Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

6. Click OK. The documents are listed under Documents in the left pane and the text of the first 
document is displayed in the right pane. 

Importing Load Files
To import a load file, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Document (from File) on the menu. The 
Document Files dialog box is displayed. 

2. Click Load File to display the Open dialog box. 

3. Click your document and click Open. The Document Files dialog box is redisplayed. 

4. Click Groups to add the documents to a data group. The Data Groups dialog box is displayed. 
Select the group to which you want to add the data and click OK. The Document Properties dialog 
box is redisplayed. 

Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.

5. Click Next. The Load Files: Select the Load File Field Delimiter dialog box is displayed (Figure 5-5). 

Figure 5-5. Load Files: Select the Load File Field Delimiter dialog box

6. In the File Type list, click the file type for the load file. The field delimiter, row delimiter, and text 
qualifier are automatically entered for you. The First row contains field names check box is 
selected, if appropriate. 

Notes

• If your load file is not listed in the File Type list, click Custom in the list. Then click the 
appropriate field delimiter, row delimiter, and text qualifier in the lists. 

• To save the field delimiter, row delimiter, and text qualifier settings for the Custom file type, click 
Save This Mapping. In the Save Mapping dialog box, type a name for the mapping in the box 
and click Save Mapping. The name of the mapping is added to the File Type list for future use.
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7. Click Next. The Load Files: Select the Load File Field Mappings dialog box is displayed 
(Figure 5-6).

Figure 5-6. Load Files: Select the Load File Field Mappings dialog box

8. Assign a title to each field in the file by mapping the field. For example, to map the first field, which 
contains beginning Bates Numbers, in Figure 5-6, click the field by clicking [none] at the top of the 
first column. Then click Bates Start in the Mapping list. Repeat this process for each field you want 
to map.

Note You can map the Doc-Level Notes, Doc-Level Issues, and Data Groups fields multiple times, 
allowing you to assign more than one column to the same field. Therefore, if the load file 
contains multiple columns with notes, coding, or other metadata, you can map all of them 
to the Doc-Level Notes, Doc-Level Issues, and Data Groups fields, and then include that 
data in searches and reports.

9. If you do not want to import a field, select the field and then select the Do not import field (Skip) 
check box.

10. If a field indicates that the load file contains a row for each page of a document, select the field. 
Then select the Field indicates start of new document when check box and click an option in the 
list. 

11. Click Finish. The Import Completed dialog box with a list of the documents that you imported is 
displayed.

Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

12. Click OK. The documents are listed under Documents in the left pane.

Sending Documents to Case Notebook Using Windows Explorer
You can send documents that are saved on your computer to Case Notebook using Windows Explorer. 
To send a document using Windows Explorer, complete these steps:

1. Locate the document you want to send.
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2. Right-click the document, then point to Send To and click Case Notebook as Document on the 
menu (Figure 5-7). The Document Properties dialog box is displayed. 

Figure 5-7. Windows Explorer menu

3. Fill in the boxes as appropriate.

4. Click Finish.The Import Completed dialog box with a list of the documents that you imported is 
displayed.

Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

5. Click OK. The document is listed under Documents in the left pane and the text of the document is 
displayed in the right pane.

Sending Documents to Case Notebook from Microsoft Outlook
You can send email and attached documents to Case Notebook directly from Microsoft Outlook. When 
you install Case Notebook, a Case Notebook menu is automatically displayed in Microsoft Outlook, 
shown outlined in Figure 5-8.

Figure 5-8. Case Notebook menu in Microsoft Outlook

To send an email and an attached document from Microsoft Outlook, complete these steps: 

1. Access Microsoft Outlook.

2. You can do one of the following:

• Click the email you want to send, then on the Case Notebook menu, click Send as Document. 

• Right-click the email and click Send to Case Notebook as Document on the menu.

The Load Files dialog box is displayed.

3. Click Groups to add the sent documents to a data group. The Data Groups dialog box is displayed. 
Select the group to which you want to add the document and click OK.
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Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.

4. Click Finish. The Import Completed dialog box with a list of the documents that you imported is 
displayed.

Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

5. Click OK. The email and attachment are listed under Documents in the left pane and the text of 
the email is displayed in the right pane (Figure 5-9).

Figure 5-9. Email and attached document

Sending Documents to Case Notebook from Westlaw CaseLogistix
When you send a document from Westlaw CaseLogistix 5.4 or later, Case Notebook 3.0 or later can 
receive the document with its coding, Shared Tags, redactions, and notes. Additionally, some 
CaseLogistix fields will automatically map to comparable fields in Case Notebook, if they exist, or you 
can manually map CaseLogistix fields to the Data Groups, Doc-Level Issues, and Doc-Level Notes fields 
in Case Notebook. (For further information on these Case Notebook fields, see ”Working with 
Properties” on page 79.) 

Notes

• If a CaseLogistix field is not mapped to a Case Notebook field, the data in that field will not be 
available in Case Notebook. Refer to step 9 below on how to manually map a CaseLogistix field 
to a Case Notebook field.

• If you change information in the CaseLogistix document after you send it to Case Notebook, 
those changes are not reflected in the document in Case Notebook.
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The following list shows how features in CaseLogistix translate into features in Case Notebook. 

You can determine which CaseLogistix features you want to include in Case Notebook during the send 
process. See steps 2–6 below.

To send a document from CaseLogistix to Case Notebook, complete these steps:

1. Right-click the document in CaseLogistix you want to send to Case Notebook, then point to Send 
To and click Case Notebook as Document on the menu. The Send to Case Notebook Options 
dialog box is displayed (Figure 5-10).

Figure 5-10. Send to Case Notebook Options dialog box

2. Select or clear the appropriate check boxes.

Westlaw CaseLogistix Westlaw Case Notebook

Shared Tags Doc-Level Issues

Notes Doc-Level Notes

IntelliFolders Data Groups

Redactions Redactions Issues

Anchor Notes Annotations
32      Managing Documents



3. Click Next. The Select Tags to Send as Doc-Level Issues dialog box is displayed (Figure 5-11).

Figure 5-11. Select Tags to send as Doc-Level Issues dialog box

4. By default, all tags are selected. Clear the appropriate check boxes, if desired.

5. Click Next. The Select IntelliFolders to Send as Groups dialog box is displayed (Figure 5-12). 

Figure 5-12. Select IntelliFolders to send as Groups dialog box

6. By default, all IntelliFolders are selected. Clear the appropriate check boxes, if desired.

7. Click Finish. Case Notebook opens and the Open Case dialog box is displayed.
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8. Select the case into which you want to import the document and click OK. The Load Files dialog 
box is displayed (Figure 5-13). 

Figure 5-13. Load Files dialog box

9. Scroll through the dialog box to view all the column headings. A [none] column heading indicates 
a CaseLogistix field that was not automatically mapped to a Case Notebook field, shown outlined 
in Figure 5-13. If a CaseLogistix field is not mapped to a Case Notebook field, the data in that field 
is not available in Case Notebook. To map the field, click the [none] column heading, then, in the 
Mappings list, click Data Groups, Doc-Level Issues, or Doc-Level Notes, also shown outlined in 
Figure 5-13. You can map as many CaseLogistix fields to these Case Notebook fields as necessary. 
(For further information on the Case Notebook fields, see ”Working with Properties” on page 79.) 

10. When you have finished mapping the fields, click Finish. The Import Completed dialog box with a 
list of the documents that you imported is displayed.

Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

11. Click OK. The document is listed under Documents in the left pane and the text of the document is 
displayed in the right pane

Opening an Original CaseLogistix Document
After you send a document from CaseLogistix to Case Notebook, you can quickly access the original 
document in CaseLogistix from Case Notebook. To open an original CaseLogistix document, do one of 
the following:
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• Right-click the document in the left pane and click Properties on the menu. The Document 
Properties dialog box is displayed. Click Open in Westlaw CaseLogistix shown outlined in 
Figure 5-14.

Figure 5-14. Document Properties dialog box

• Click Documents in the left pane to display the Document List in the right pane. Click Columns, 
then click Open in Westlaw CaseLogistix on the menu. The Open in Westlaw CaseLogistix column 
heading is added to the Document List and an icon is displayed in the column for each document 
you sent from CaseLogistix, shown outlined in Figure 5-15. For further information, see ”Using the 
Document List” on page 36.

Figure 5-15. CaseLogistix document in Document List

Opening an Existing Document 
To open a document, complete these steps:

1. If necessary, click Documents in the left pane to display a list of all documents in the case.

2. Double-click the document you want to open. The text of the document is displayed in the right 
pane. 
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Using the Document List
When you click Documents in the left pane, the list of documents is displayed as a table in the right 
pane that includes document properties, e.g., Bates numbers, dates, notes, and issues (Figure 5-16). 

Figure 5-16. Document List

SORTING DOCUMENTS
To sort documents in the Document List, click a column heading.

ADDING AND REMOVING COLUMNS
To add or remove a column in the table, click Columns on the toolbar above the table, then click a 
column on the menu.

FREEZING THE FIRST COLUMN
To freeze the first column of the table, right-click the first column header and click Freeze First Column 
on the menu.

DELETING SINGLE AND MULTIPLE DOCUMENTS
• To delete a single document, right-click the document in the table and click Delete on the menu. 

• To delete multiple documents, press the Ctrl or Shift key to select the documents, then right-click 
the selection and click Delete on the menu. 

When you click Delete on the menu, the message Permanently delete the selected Document and all 
associated Annotations? is displayed. Click Yes.

Viewing Document Properties
To view the properties of a document, right-click the document name in the left pane and click 
Properties on the menu. For further information on properties, see ”Working with Properties” on page 
79.

Closing a Document

To close a document so that it is no longer displayed in the right pane, click the Close button ( ) on 
the document’s tab.
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6 Managing Pleadings

Case Notebook allows you to add pleadings to categorize and search.

Importing a Pleading
To import a pleading, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Pleading (from File) on the menu. The 
Pleading Files dialog box is displayed. 

2. Click Add to display the Open dialog box. 

3. Click your pleading and click Open. The Pleading Files dialog box is redisplayed.

4. To add the pleading to a data group, click Groups. The Data Groups dialog box is displayed. Select 
the group to which you want to add the pleading and click OK. The Pleading Properties dialog box 
is redisplayed. 

Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.

5. Click Next. The Pleading Properties dialog box is displayed (Figure 6-1).

Figure 6-1. Pleading Properties dialog box

6. By default, the title of the pleading is entered for you in the Title box. Type a different title for the 
pleading, if desired.

7. In the Type list, click a type, if desired.

8. In the Author box, type the author’s name or click the name in the list, if desired.

9. In the Recipient box, type the recipient’s name or click the name in the list, if desired. 

10. Select the Document Date check box, if desired. When you select this check box, the current day’s 
date is entered in the box automatically. Click the arrow to select another date.

11. The OCR check box is automatically selected if the pleading is an image file or PDF file.
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12. In the Doc-Level Notes box, type a note, if desired. The note will be displayed in the pleading’s 
Annotations folder in the left pane and on the Overview and Doc-Level Notes tabs in the Pleading 
Properties dialog box. Additionally, you can include the note text in a search. For further 
information, see ”Adding Doc-Level Notes” on page 83.

13. Click Finish. The Import Completed dialog box with a list of the pleadings that you imported is 
displayed.

Note If Case Notebook fails to import a pleading, an error message is displayed in the dialog box. 
You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

14. Click OK. The pleading is listed under Pleadings in the left pane and the text of the pleading is 
displayed in the right pane (Figure 6-2).

Figure 6-2. Imported pleading

Sending Pleadings to Case Notebook Using Windows Explorer
You can send pleadings that are saved on your computer to Case Notebook using Windows Explorer. To 
send a pleading using Windows Explorer, complete these steps:

1. Locate the pleading you want to send.

2. Right-click the pleading, then point to Send To and click Case Notebook as Pleading on the menu 
(Figure 6-3). The Pleading Properties dialog box is displayed.

Figure 6-3. Windows Explorer menu
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3. Fill in the boxes as appropriate.

4. Click Finish. The Import Completed dialog box with a list of the pleadings that you imported is 
displayed.

Note If Case Notebook fails to import a pleading, an error message is displayed in the dialog box. 
You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

5. Click OK. The pleading is listed under Pleadings in the left pane and the text of the pleading is 
displayed in the right pane.

Sending Pleadings to Case Notebook from Microsoft Outlook
You can send email and attached pleadings to Case Notebook directly from Microsoft Outlook. When 
you install Case Notebook, a Case Notebook menu is automatically displayed in Microsoft Outlook 
(Figure 6-4).

Figure 6-4. Case Notebook menu in Microsoft Outlook

To send an email and an attached pleading from Microsoft Outlook, complete these steps: 

1. Access Microsoft Outlook.

2. You can do one of the following:

• Click the email you want to send, then on the Case Notebook menu, click Send as Pleading. 

• Right-click the email and click Send to Case Notebook as Pleading on the menu.

The Load Files dialog box is displayed.

3. Click Groups to add the sent pleadings to a data group. The Data Groups dialog box is displayed. 
Select the group to which you want to add the pleading and click OK.

Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.

4. Click Finish. The Import Completed dialog box with a list of the pleadings that you imported is 
displayed.

Note If Case Notebook fails to import a pleading, an error message is displayed in the dialog box. 
You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.
Managing Pleadings      39



5. Click OK. The email and attachment are listed under Pleadings in the left pane and the text of the 
email is displayed in the right pane (Figure 6-5).

Figure 6-5. Email and attached pleading

Sending Pleadings to Case Notebook from Westlaw CaseLogistix
When you send a pleading from Westlaw CaseLogistix 5.4 or later, Case Notebook 3.0 or later can 
receive the pleading with its coding, Shared Tags, redactions, and notes. Additionally, some 
CaseLogistix fields will automatically map to comparable fields in Case Notebook, if they exist, or you 
can manually map CaseLogistix fields to the Data Groups, Doc-Level Issues, and Doc-Level Notes fields 
in Case Notebook. (For further information on these Case Notebook fields, see ”Working with 
Properties” on page 79.) 

Notes

• If a CaseLogistix field is not mapped to a Case Notebook field, the data in that field will not be 
available in Case Notebook. Refer to step 9 below on how to manually map a CaseLogistix field 
to a Case Notebook field.

• If you change information in the CaseLogistix document after you send it to Case Notebook, 
those changes are not reflected in the document in Case Notebook.

The following list shows how features in CaseLogistix translate into features in Case Notebook. 

You can determine which CaseLogistix features you want to include in Case Notebook during the send 
process. See steps 2–6 below.

Westlaw CaseLogistix Westlaw Case Notebook

Shared Tags Doc-Level Issues

Notes Doc-Level Notes

IntelliFolders Data Groups

Redactions Redactions Issues

Anchor Notes Annotations
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To send a pleading from CaseLogistix to Case Notebook, complete these steps:

1. Right-click the pleading in CaseLogistix you want to send to Case Notebook, then point to Send To 
and click Case Notebook as Pleading on the menu. The Send to Case Notebook Options dialog 
box is displayed (Figure 5-10).

Figure 6-6. Send to Case Notebook Options dialog box

2. Select or clear the appropriate check boxes.

3. Click Next. The Select Tags to Send as Doc-Level Issues dialog box is displayed (Figure 5-11).

Figure 6-7. Select Tags to send as Doc-Level Issues dialog box

4. By default, all tags are selected. Clear the appropriate check boxes, if desired.
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5. Click Next. The Select IntelliFolders to Send as Groups dialog box is displayed (Figure 5-12). 

Figure 6-8. Select IntelliFolders to send as Groups dialog box

6. By default, all IntelliFolders are selected. Clear the appropriate check boxes, if desired.

7. Click Finish. Case Notebook opens and the Open Case dialog box is displayed.

8. Select the case into which you want to import the pleading and click OK. The Load Files dialog box 
is displayed (Figure 5-13). 

Figure 6-9. Load Files dialog box

9. Scroll through the dialog box to view all the column headings. A [none] column heading indicates 
a CaseLogistix field that was not automatically mapped to a Case Notebook field, shown outlined 
in Figure 5-13. If a CaseLogistix field is not mapped to a Case Notebook field, the data in that field 
is not available in Case Notebook. To map the field, click the [none] column heading, then, in the 
Mappings list, click Data Groups, Doc-Level Issues, or Doc-Level Notes, also shown outlined in 
Figure 5-13. You can map as many CaseLogistix fields to these Case Notebook fields as necessary. 
(For further information on the Case Notebook fields, see ”Working with Properties” on page 79.) 

10. When you have finished mapping the fields, click Finish. The Import Completed dialog box with a 
list of the pleadings that you imported is displayed.
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Note If Case Notebook fails to import a pleading, an error message is displayed in the dialog box. 
You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

11. Click OK. The pleading is listed under Documents in the left pane and the text of the document is 
displayed in the right pane

Opening an Original CaseLogistix Pleading
After you send a pleading from CaseLogistix to Case Notebook, you can quickly access the original 
pleading in CaseLogistix from Case Notebook. To open an original CaseLogistix pleading, right-click 
the pleading in the left pane and click Properties on the menu. The Pleading Properties dialog box is 
displayed. Click Open in Westlaw CaseLogistix, shown outlined in Figure 5-14.

Figure 6-10. Document Properties dialog box

• Click Documents in the left pane to display the Document List in the right pane. Click Columns 
and click Open in Westlaw CaseLogistix on the menu. The Open in Westlaw CaseLogistix column 
heading is added to the Document List and an icon is displayed in the column for each document 
you sent from CaseLogistix, shown outlined in Figure 5-15. For further information, see ”Using the 
Document List” on page 36.

Figure 6-11. CaseLogistix document in Document List

Opening an Existing Pleading 
To open a pleading, complete these steps:

1. If necessary, click Pleadings in the left pane to display a list of all pleadings in the case.

2. Double-click the pleading you want to open. The text of the pleading is displayed in the right pane. 

Viewing Pleading Properties
To view the properties of a pleading, right-click the pleading name in the left pane and click Properties 
on the menu. For further information on properties, see ”Working with Properties” on page 79.

Deleting a Pleading 
To delete a pleading, right-click the pleading in the left pane and click Delete on the displayed menu. 
The message Permanently delete the selected Pleading and all associated Annotations? is displayed. 
Click Yes.
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Closing a Pleading

To close a pleading so that it is no longer displayed in the right pane, click the Close button ( ) on the 
pleading’s tab.
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7 Managing Research

If you are conducting research on Westlaw or WestlawNext, you can send your search result to Case 
Notebook. From Case Notebook, you can quickly update KeyCite information and access Westlaw or 
WestlawNext to conduct further research. 

Searching Westlaw
For more information on using Westlaw, download a free copy of the Westlaw User Guide at 
store.westlaw.com/support/user-guide/westlaw.

To search Westlaw, complete these steps:

1. On the Search menu in Case Notebook, click Westlaw Search. The Westlaw Search Options dialog 
box is displayed (Figure 7-1).

Figure 7-1. Westlaw Search Options dialog box

2. By default, Search Westlaw is selected. To search Westlaw Canada, select Search Westlaw 
Canada. Click Save. The Search Westlaw dialog box is displayed (Figure 7-2).
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Note When you click Save, your preference is stored as a cookie in your browser. To view the 
options again, you must first delete cookies from your browser, then repeat step 1. 

Figure 7-2. Search Westlaw dialog box

3. By default, the Terms and Connectors tab is displayed. Type your Terms and Connectors query, 
e.g., retaliat! wrongful! /5 terminat! discharg! /s work! /5 compensat! & da(aft 2006), in the 
Terms box.

4. Under Source, type a database identifier in the box or click a database, e.g., All Federal Cases 
(ALLFEDS), in the list.

5. Click Search Westlaw. The Sign On with OnePass page is displayed.

6. Type your OnePass username, password, and client identifier in the boxes. 

7. Click Sign On. The result list for your search is displayed (Figure 7-3). 

Figure 7-3. Result list
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USING WESTLAW FIND & PRINT
You can use the Westlaw Find & Print feature to retrieve documents by citation and send them directly 
to Case Notebook. To send documents to Case Notebook, complete these steps:

1. Click Find&Print at the top of any page to display the Find a Document page (Figure 7-4).

Figure 7-4. Find a Document page

2. In the Enter Citation(s) box in the right frame, type one or more citations. You can type up to 20 
citations; separate them with a semicolon or hard return.

3. Under Select Delivery Options, click Export to Case Notebook.

4. Click Send Request. The Export to Case Notebook dialog box is displayed.

5. Complete steps 2–10 below to view the documents in Case Notebook.

SENDING A SEARCH RESULT TO CASE NOTEBOOK
After conducting your research, you can send the result list or selected documents to Case Notebook. 
To send the result list or selected documents to Case Notebook, complete these steps:

1. To send the result list, click the Export to Case Notebook icon ( ) in the upper-right corner. To 
send specific documents in the result list, select the check box next to each document you want to 
send and then click the Export to Case Notebook icon. The Export to Case Notebook page is 
displayed (Figure 7-5).

Figure 7-5. Export to Case Notebook page
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2. Make certain the matter number corresponds to the client-matter number for the case in Case 
Notebook. (To view the client-matter number for the case, click Case Properties on the File menu 
in Case Notebook.)

3. Click an issue in the Recent Categories list, if desired.

4. In the Comments box, type a comment, if desired.

5. Click Save. The Download Confirmation dialog box is displayed. 

6. Click Complete Download. The File Download dialog box is displayed. 

7. Click Open. The Research Files dialog box is displayed. 

8. To add the document to a data group, click Groups. The Data Groups dialog box is displayed. 
Select the group to which you want to add the document and click OK. The Research Files dialog 
box is redisplayed. 

Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.

9. Click Finish. The Import Completed dialog box with a list of the documents that you imported is 
displayed.

Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

10. Click OK.The result list or documents you selected are listed under Research in the left pane and 
the result list or the text of the first document is displayed in the right pane (Figure 7-6).

Figure 7-6. Imported research document
48      Managing Research



Searching WestlawNext
For further information on WestlawNext, download a free copy of Welcome to WestlawNext: Introducing 
the Basics at store.westlaw.com/support/user-guide/westlaw.

To search WestlawNext, complete these steps:

1. On the Search menu in Case Notebook, click Westlaw Search. The Westlaw Search Options dialog 
box is displayed (Figure 7-7).

Figure 7-7. Westlaw Search Options dialog box

2. Click Search WestlawNext. 

3. Click Save. The Jurisdiction dialog box is displayed (Figure 7-8).

Notes

• When you click Save, your preference is stored as a cookie in your browser. To view the options 
again, you must first delete cookies from your browser, then repeat step 1. 

• You can search Westlaw from Case Notebook, even if you selected WestlawNext as your default 
search method. To search Westlaw, open an outline, then click the Insert button and click Insert 
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Westlaw Outline on the menu. At the Search Westlaw dialog box, click the Terms and 
Connectors tab.

Figure 7-8. Search Westlaw dialog box

4. In the search box, type terms describing your issue.

5. Select up to three jurisdictions under Jurisdiction.

6. Click the search icon ( ). The WestlawNext sign-on page is displayed.

7. Type your OnePass username and password in the boxes. 

8. Click Sign On. The client ID page is displayed

9. At the next page, click Continue. unless you want to change your client ID. The result list for your 
search is displayed (Figure 7-9). 

Figure 7-9. Result list
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SENDING A WESTLAWNEXT RESEARCH DOCUMENT TO CASE NOTEBOOK
After conducting your research on WestlawNext, you can send the full text of a document to Case 
Notebook. Additionally, if you add annotations to a research result, you can send the annotations with 
the document to Case Notebook To send a document to Case Notebook, complete these steps:

1. Click the arrow next to the delivery icon and click Export to Case Notebook on the menu. The 
Export to The Export to Case Notebook dialog box is displayed (Figure 7-10).

Figure 7-10. Export to Case Notebook dialog box

2. Make certain the matter number corresponds to the client-matter number for the case in Case 
Notebook. (To view the client-matter number for the case, click Case Properties on the File menu 
in Case Notebook.)

3. Type a different title in the Title box, if desired.

4. In the Doc-Level Issue/Category box, type text that will become a Doc-Level Issue in Case 
Notebook, if desired. You can use Doc-Level Issues to categorize your research in Case Notebook 
and include them in reports. For further information, see ”Adding Doc-Level Issues” on page 80.

5. The What to Deliver options are displayed if your research document contains notes or highlights. 
You must select Document and Annotations for WestlawNext notes and highlights to become 
annotations in Case Notebook. For further information, see ”Viewing WestlawNext Annotations in 
Case Notebook” on page 52

6. Click the Layout and Limits tab to specify elements you want to include with the document. 

7. Click Export. The Ready For Download dialog box is displayed.

8. Click Download. The File Download dialog box is displayed.

9. Click Open. The Research Files dialog box is displayed. 

10. Click Finish. The Import Completed dialog box with a list of the documents that you imported is 
displayed.

Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

11. Click OK. The WestlawNext document you sent is listed under Research in the left pane and the 
text of the document is displayed in the right pane.
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VIEWING WESTLAWNEXT ANNOTATIONS IN CASE NOTEBOOK
Viewing your annotations in Case Notebook depends on how you created them in WestlawNext 
(Figure 7-11). The following chart describes the methods of creating an annotation in WestlawNext and 
how it is viewed in Case Notebook:

Figure 7-11. WestlawNext document with annotations

Creating the Annotation in WestlawNext Viewing the Annotation in Case Notebook

Click the Annotations icon ( ) above the 
document and click Add Note on the menu. 
Type a note in the Note box and click Save. 
This creates a Doc-Level Note in Case 
Notebook.

• Open the Annotations folder in the left pane 
under the document, then click the plus 
symbol (+) next to the Doc-Level folder.

• Right-click the document in the left pane 
and click Properties on the menu. The note 
is displayed on the Overview and Doc-Level 
Notes tabs in the Research Properties 
dialog box.

Select text in the document and click 
Highlight on the menu. This creates an 
annotation in Case Notebook.

1. Open the Annotations folder in the left 
pane under the document, 

2. Click the plus symbol (+) next to 
Unassigned. 

3. Double-click the annotation to jump to 
the highlighted text in the document. 

Select text in the document and click Add a 
Note on the menu. Type a note in the box and 
click Save. This creates an annotation and an 
annotation note in Case Notebook.

1. Open the Annotations folder in the left 
pane under the document, 

2. Click the plus symbol (+) next to 
Unassigned. 

3. Right-click the annotation and click Edit 
Annotation on the menu.

4. Click the Note tab in the Annotation 
Properties dialog box.
52      Managing Research



Updating KeyCite Information
You can quickly update KeyCite information for a research document in Case Notebook. To update 
KeyCite information, complete these steps:

1. On the Tools menu, click Update KeyCite Flags. The Update KeyCite Login dialog box is displayed 
(Figure 7-12). 

2. Type your OnePass username and password in the boxes and click OK. 

3. The Update KeyCite Report is listed under Report in the left pane and the text of the report is 
displayed in the right pane (Figure 7-13).

Figure 7-13. Update KeyCite Report

Note Research items with a changed status will be highlighted in yellow. 

Sending Research Documents to Case Notebook Using Windows Explorer
You can send research documents that are saved on your computer to Case Notebook using Windows 
Explorer. To send a research document using Windows Explorer, complete these steps:

1. Locate the research document you want to send.

Figure 7-12. Update KeyCite Login dialog box 
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2. Right-click the research document, then point to Send To and click Case Notebook as Research on 
the menu (Figure 6-3). The Research Properties dialog box is displayed.

Figure 7-14. Windows Explorer menu

3. Fill in the boxes as appropriate.

4. Click Finish. The Import Completed dialog box with a list of the documents that you imported is 
displayed.

Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

5. Click OK. The research document is listed under Research in the left pane and the text of the 
research document is displayed in the right pane.

Importing Research Documents
You can import other research documents into Case Notebook.

To import a research document, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Research (from File) on the menu. The 
Research Files dialog box is displayed.

2. Click Add to display the Open dialog box.

3. Click your research document and click Open. The Research Files dialog box is redisplayed.

4. To add the document to a data group, click Groups. The Data Groups dialog box is displayed. 
Select the group to which you want to add the document and click OK. The Research Files dialog 
box is redisplayed. 

Note You can use data groups to organize data in categories, which are displayed as folders 
under data categories in the left pane. For more information on data groups, see ”Working 
with Data Groups” on page 104.
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5. Click Next. The Research Properties dialog box is displayed (Figure 7-15).

Figure 7-15. Research Properties dialog box

6. By default, the title of the document is entered in the Title box. Type a different title, if desired.

7. In the Type list, click a document type, if desired.

8. In the Author list, click an author, if desired.

9. Select the Research Date check box, if desired. When you select this check box, the current day’s 
date is entered in the box automatically. Click the arrow to select another date.

10. The OCR check box is automatically selected if the document is an image file or PDF file.

11. In the Doc-Level Notes box, type a note, if desired. The note will be displayed in the research 
document’s Annotations folder in the left pane and on the Overview and Doc-Level Notes tabs in 
the Research Properties dialog box. Additionally, you can include the note text in a search. For 
further information, see ”Adding Doc-Level Notes” on page 83.

12. Click Finish. The Import Completed dialog box with a list of the documents that you imported is 
displayed.

Note If Case Notebook fails to import a document, an error message is displayed in the dialog 
box. You can record the error by clicking Copy to Clipboard and pasting the message into 
another application.

13. Click OK. The research document is listed under Research in the left pane and the text of the 
document is displayed in the right pane.
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8 Managing Key Facts

Case Notebook allows you to create key facts to quickly and easily organize, view, and share the most 
important facts in the litigation.

Creating a Key Fact
To create a key fact, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Key Fact on the menu. The Key Fact 
Properties dialog box–Details tab is displayed (Figure 8-1).

Figure 8-1. Key Fact Properties dialog box–Details tab

2. On the Details tab, 

• in the Title box, type a name for the key fact, e.g., Investigation Report.

• select the Start Date check box, if desired. If you have not previously created any key facts, the 
current day’s date is entered in the box automatically. Otherwise, the start date of the last key 
fact you created is entered. Type a new start date or click the arrow to select another start date.

• select the Set Time check box, if desired. If you have not previously created any key facts, 
12:00PM is entered in the box automatically. Otherwise, the start time of the last key fact you 
created is entered. Type a different start time, if desired. 

• select the End Date check box, if desired. If you have not previously created any key facts, the 
current day’s date is entered in the box automatically. Otherwise, the end date of the last key 
fact you created is entered. Type a new end date or click the arrow to select another end date.

• select the Set Time check box, if desired. If you have not previously created any key facts, 
12:00PM is entered in the box automatically. Otherwise, the end time of the last key fact you 
created is entered. Type a different end time, if desired. 

• in the Description box, type a description, e.g., Request for investigation made by supervisor.

• clear the Undisputed check box, if desired.

3. Click the Issues tab and select one or more issues, if desired. Issues will be listed on this tab only if 
they have previously been created. See ”Working with Issues” on page 86.

4. Click the Sources tab and select one or more sources, if desired. Sources will be listed on this tab 
only if annotations have previously been created. See ”Working with Annotations” on page 91.
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5. Click the Characters tab and select one or more characters, if desired. Characters will be listed on 
this tab only if they have previously been created. See ”Managing Characters” on page 61.

6. Click the Overview tab to review your selections, if desired (Figure 8-2). 

Note You can click any item on the Overview tab to display the appropriate tab, where you can 
edit the information.

Figure 8-2. Key Fact Properties dialog box–Overview tab

7. Click OK. The key fact is listed under Key Facts in the left pane and displayed on the Key Facts tab 
in the right pane (Figure 8-3). 

Figure 8-3. Key Facts tab
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Creating a Key Facts Report
To create a Key Facts report, complete these steps:

1. On the Main Menu toolbar, click the Report button ( ), then click Key Facts on the menu. 
The Key Facts Report Properties dialog box is displayed (Figure 8-4). 

Figure 8-4. Key Facts Report Properties dialog box

2. All of the key facts in the case are selected on the Data tab by default. To remove a key fact from 
the report, clear its check box.

3. Clear the Include disputed facts check box if you want to exclude disputed facts from the report 
and create an undisputed facts report.

4. Clear the Include undisputed facts check box if you want to exclude undisputed facts from the 
report and create a disputed facts report.

5. Clear the Group by undisputed facts check box if you do not want to group undisputed facts in the 
report to create a report with undisputed and disputed facts grouped together.

6. Click the Display tab to view a list of display options. You can

• in the Title box, type a title for the report, if desired.

• by default, the key facts are sorted by Title in the report; click Date in the Sort By list, if desired.

• select or clear the appropriate check boxes under Key Facts.

• select the Include cover page when printing or saving check box, if desired.
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7. Click OK. The Key Facts report is listed under Report in the left pane and the text of the report is 
displayed on the Report tab in the right pane (Figure 8-5).

Figure 8-5. Key Facts report

When viewing the report, you can

• click the heading next to a key fact icon in the report to go to the key fact on the Key Facts tab.

• click the Hit arrows in the left pane to view the next or previous key fact in the report. 

Editing a Key Fact
To edit a key fact, right-click the key fact and click Properties on the menu. The Key Fact Properties 
dialog box is displayed. Make the appropriate changes and click OK.

Deleting a Key Fact 
To delete a key fact, right-click the key fact and click Delete on the menu. The message Permanently 
delete the selected Key Fact? is displayed. Click Yes.

Closing the Key Facts Tab

To close the Key Facts tab so that it is no longer displayed in the right pane, click the Close button ( ) 
on the tab.

Sending Key Facts to Microsoft Word or Corel WordPerfect
You can send key facts to Microsoft Word or Corel WordPerfect and then work with them in that word-
processing program. To send key facts to a Microsoft Word or Corel WordPerfect, select the check boxes 
next to the key facts you want to send. Then click Send on the toolbar above the key facts in the right 
pane and click Word or WordPerfect on the menu. The program you selected opens and the key facts 
are displayed in a document.

Sending Key Facts to West Case Timeline
You can send key facts to West Case Timeline and use them to create a chart. For more information on 
West Case Timeline, refer to the West Case Timeline User Guide, which you can download at 
store.westlaw.com/support/user-guide/livenote-case-notebook.aspx. 

To send key facts to West Case Timeline, complete these steps:

1. Select the check boxes next to the key facts you want to send.
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2. Click Send on the toolbar above the key facts in the right pane, then click West Case Timeline on 
the menu.

3. The message Would you like to view import results? is displayed. Click Yes if you want to display a 
dialog box summarizing the results of the import.

4. If you clicked Yes in step 3, the Import_log.txt–Notepad dialog box is displayed. Click the Close 
button. The key facts are displayed as events on the Event Entry tab in West Case Timeline.

Notes

• If West Case Timeline is not open when you send the key facts, West Case Timeline opens 
automatically and creates a new timeline file for you. If you are working in one or more timelines 
when you send the key facts, the key facts are displayed in the last timeline you accessed.

• If you modify a key fact in Case Notebook, you must resend the key fact to West Case Timeline to 
update the event. Only the modified information in the key fact is sent from Case Notebook. 

SAVING KEY FACTS AS A WEST CASE TIMELINE FILE
If desired, you can also save your key facts as a West Case Timeline (TAB) file and then import the file 
into West Case Timeline.

To create a West Case Timeline file, complete these steps:

1. Click Save As above the key facts in the right pane. The Save As dialog box is displayed.

2. Click a location for the West Case Timeline file.

3. In the File name box, type a file name.

4. In the Save as type list, click West Case Timeline (*.tab).

5. Click Save.
60      Managing Key Facts



9 Managing Characters

With Case Notebook, you can easily keep track of all the characters in the litigation, such as parties, 
attorneys, experts, and witnesses, and their contact information.

Adding Characters
You can add characters to a case manually, set Case Notebook to add characters automatically, or add 
characters from a smart tags list. 

To add characters manually, you can

• create a character

• import characters from a comma separated value (CSV) file

Case Notebook can add characters automatically when you

• enter or change the properties in a transcript, document, pleading, or outline

• import transcripts, documents, or pleadings

ADDING CHARACTERS MANUALLY 
Creating a Character

To create a character, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Character on the menu. The Character 
Properties dialog box is displayed (Figure 9-1).

Figure 9-1. Character Properties dialog box

2. Fill in the boxes as appropriate.
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3. Click OK. The character is listed under Characters in the left pane and displayed on the Characters 
tab in the right pane (Figure 9-2). 

Figure 9-2. Characters tab

Importing Characters from a CSV File

You can import a CSV file that contains information about characters. If desired, you can create a CSV 
file by exporting characters from Case Notebook or contacts from Microsoft Outlook. For further 
information on exporting characters from Case Notebook, see ”Exporting Characters to a File” on page 
67.

Note The CSV file must contain the same fields as those for contacts in Microsoft Outlook.

To import characters from a CSV file, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Characters (from File) on the menu. The 
Open dialog box is displayed. 

2. Select the file containing the characters you want to import and click Open. A message indicating 
that the characters were successfully imported or updated is displayed. 

3. Click OK. The characters are listed under Characters in the left pane and displayed on the 
Characters tab in the right pane. 

ADDING CHARACTERS AUTOMATICALLY 
Changing the Properties of Transcripts, Documents, Pleadings, and Outlines

Case Notebook automatically adds characters when you add or change the name of a deponent in a 
transcript or outline or the author or recipient in a document or pleading. 

To change the deponent, author, or recipient information, complete these steps:

1. Right-click the transcript, document, pleading, or outline you want to change in the left pane, then 
click Properties on the menu. The Properties dialog box is displayed. 

2. Click the Details tab.

3. Make the changes in the appropriate boxes.

4. Click OK. The character is listed under Characters in the left pane.

If you do not want Case Notebook to add a character when you change the information in a transcript, 
document, pleading, or outline, complete these steps:

1. On the Tools menu, click Options. The Options dialog box is displayed. 
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2. Click the Characters tab (Figure 9-3).

Figure 9-3. Options dialog box–Characters tab

3. Under Automatically Create Characters from Properties, clear the appropriate check box.

4. Click OK. 

Importing Transcripts, Documents, and Pleadings

When you import a transcript, document, or pleading, Case Notebook scans the text and identifies the 
words that appear to be the names of persons or companies. You can set Case Notebook to 
automatically add those names as characters to a case. To set Case Notebook to automatically add 
characters when you import a transcript, document, or pleading, complete these steps:

1. On the Tools menu, click Options. The Options dialog box is displayed. 

2. Click the Characters tab (Figure 9-4).

Figure 9-4. Options dialog box–Characters tab

3. Under Automatically Create Characters from Full Text, select the Create new characters from full 
text of transcripts, documents, and pleadings check box.

4. Click OK.
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ADDING CHARACTERS FROM A SMART TAGS LIST
When you import a transcript, document, or pleading, Case Notebook uses character recognition 
software to identify words that appear to be the names of persons or companies. It then adds smart 
tags, or links to the character information, to those names and generates a list of the smart tags. You 
can use the list to find references to additional witnesses and specify the characters you want to add to 
the case. 

Characters with smart tags are underlined with a blue dotted line, shown outlined in Figure 9-5. You 
can right-click a smart tag to

• modify a character’s information

• delete the smart tag 

• create a Character report

• retrieve a character’s profile on Westlaw

Figure 9-5. Smart tag 

Notes

• You cannot delete or modify smart tags when you replicate the case offline.

• Smart tags are displayed in the transcript, document, or pleading only when the characters are 
displayed on the Characters tab. 

To add characters to a case from smart tags list, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Character (from Smart Tags) on the 
menu. The Character Smart Tags Wizard dialog box is displayed (Figure 9-6).

Figure 9-6. Character Smart Tags Wizard dialog box

2. By default, all of the characters are selected. To exclude a character, clear its check box.
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3. Click Finish. The characters are listed under Characters in the left pane and the smart tags are 
displayed in the transcript, document, or pleading you imported.

To set Case Notebook to automatically add the characters to the case when you import a transcript, 
document, or pleading, see ”Importing Transcripts, Documents, and Pleadings” on page 63.

Working with Aliases
When you import a transcript, document, or pleading, Case Notebook scans the text for both the names 
of individuals and companies and the variations, or aliases, of those names. Case Notebook then 
creates a list of the aliases. For example, if Case Notebook identifies the character Joseph Adams, it 
may create the alias Joe. You can associate aliases with a character to include all references to the 
character in a Characters report. 

To associate an alias with a character, complete these steps:

1. Click Characters in the left pane to display the Characters tab in the right pane, if necessary. 

2. Right-click the character with which you want to associate an alias, e.g., Bower, Gil R., and click 
Properties on the menu. The Character Properties dialog box is displayed.

3. Click the Aliases tab (Figure 9-7). 

Figure 9-7. Character Properties dialog box–Aliases tab

4. Under Other Aliases and Characters, select the aliases, e.g., Bower, Gil, Gil Bower, and GIL R., you 
want to associate with the character. 

5. Click the left arrow to move the aliases under Aliases for Displayed Name.

6. Click OK. The message Changes to aliases will not be reflected in Character Smart Tags until you 
rebuild the Character Smart Tag index. Do you want to rebuild it now? is displayed. 

7. Click Yes. 

Retrieving a Character’s Profile from Westlaw
Character profiles on Westlaw provide background information on individuals and companies including 
assets; civil filings; criminal records; lawsuit records; corporate records; connections between 
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individuals and companies; and links to cases, jury trials, and settlements in which an attorney, judge, 
or expert witness has participated.

To retrieve a character’s profile from Westlaw, complete these steps:

1. Click Characters in the left pane to display the Characters tab in the right pane, if necessary. 

2. in the right pane, right-click the character for whom you want to retrieve a profile and click Profile 
on Westlaw on the menu. Then click one of the following on the submenu: 

• PeopleMap (public records) to search public records using the tabbed PeopleMap page

• Expert Library to search expert materials at the tabbed Expert Center page

• Person and Company Library to search materials for people and companies at the tabbed 
Person and Company Investigator page

• Attorneys and Judges to search the Profiler–Profiles of Attorneys and Judges database 
(PROFILER-WLD), which includes the profiles of attorneys and judges from all 50 states, Puerto 
Rico, the Virgin Islands, the District of Columbia, Canada, England, and Europe)

• Arbitrators to search the Profiler–Profiles of Arbitrators database (PROFILER-ARB), which 
includes the profiles of arbitrators identified in securities, labor, and international arbitration 
awards and other Westlaw resources 

Note Some sources may not be included in your Westlaw subscription.

3. At the Sign On with One Pass page, type your OnePass username and password and a client 
identifier in the boxes and click Sign On. 

4. Depending on the source you selected in step 2, the appropriate tabbed page or Search page is 
displayed.

Note For further information on searching public records on Westlaw, download a free copy of 
Searching Public Records on Westlaw or Westlaw PeopleMap at store.westlaw.com/support
/user-guide/westlaw. 

5. After you retrieve a character’s profile, click the Export to Case Notebook icon ( ) in the upper-
right corner of the profile. The Export to Case Notebook page is displayed.

6. Make certain the matter number corresponds to the client-matter number for the case in Case 
Notebook. (To view the client-matter number for the case, on the File menu in Case Notebook, 
click Case Properties.)

7. In the Recent Categories list, click an issue, if desired.

8. In the Comments box, type a comment, if desired.

9. Click Save. The Download Confirmation dialog box is displayed. 

10. Click Complete Download. The File Download dialog box is displayed. 

11. Click Open. The Research Files dialog box is displayed. 

12. Click Finish. The character’s profile is listed under Research in the left pane and the text of the 
profile is displayed in the right pane.

Creating a Characters Report
When you import data, Case Notebook automatically links the names you list under Characters with 
references to those names in the text of transcripts, documents, or pleadings. This report lists every 
instance where a character appears in the data. To create a Characters report, complete these steps: 
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1. On the Main Menu toolbar, click the Report button ( ) on the Main Menu toolbar, then 
click Characters on the menu. The Characters Report Properties dialog box is displayed 
(Figure 9-8). 

Figure 9-8. Characters Report Properties dialog box 

2. All of the characters in the case are selected on the Characters tab by default. To remove a 
character from the report, clear its check box.

3. Click the Data tab to display a list of all document types and data. By default, all document types 
and data are selected. To exclude a document type from the report, clear its check box. To exclude 
particular data from the report, click the document type containing the data, then clear the check 
boxes for the data you want to exclude. 

4. Click the Display tab to view a list of display options. You can

• type a title for the report in the Title box, if desired.

• by default, the characters are sorted by Title in the report; click an option in the Sort By list, if 
desired.

• select or clear the appropriate check boxes.

• select the Include cover page when printing or saving check box, if desired.

5. Click the Context tab to display a list of context options. Select or clear the appropriate check 
boxes. 

6. Click OK. The Characters report, which includes the lines you marked and the surrounding 
questions and answers, is listed under Report in the left pane and the text of the report is displayed 
on the Report tab in the right pane.

Exporting Characters to a File
To generate a list of characters to use apart from Case Notebook or to import into another Case 
Notebook case, you can export the characters to a file. To export characters to a file, complete these 
steps: 

1. Click Characters in the left pane, if necessary, to display the Characters tab in the right pane.
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2. Click the Save As arrow on the toolbar above the characters in the right pane, then click Save All 
on the menu, or, if you selected individual characters on the Characters tab, click Save Selected on 
the menu. The Save As dialog box is displayed.

3. Click a location for the file.

4. In the File name box, type a name for the file. 

5. In the Save as type list, click a file type.

Note If you want to import the characters into a different Case Notebook case, you must save the 
list as a CSV file.

6. Click Save. 

Editing a Character
To edit the information for a character, right-click the character and click Properties on the menu. The 
Character Properties dialog box is displayed. Make the appropriate changes and click OK.

Deleting a Character 
To delete a character, right-click the character and click Delete on the menu. The message 
Permanently delete the selected Character? is displayed. Click Yes.

Closing the Characters Tab
To close the Characters tab so that it is no longer displayed in the right pane, click the Close button 

( ) on the tab.
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10 Managing Outlines

You can use the Outlines feature in Case Notebook to gather materials in one place to prepare for 
events such as trials, depositions, arbitrations, or client interviews. For example, you can type an outline 
for a deposition and then insert links to potential exhibits, language from key documents, questions 
from transcripts, and Westlaw research into the outline. All relevant materials are organized and 
displayed under Outlines in the left pane for easy access and printing.

Creating an Outline
To create an outline, complete these steps:

1. On the Main Menu toolbar, click the New arrow, then click Outline on the menu. The Create New 
Outline dialog box is displayed (Figure 10-1).

Figure 10-1. Create New Outline dialog box

2. Under Deponent, 

• in the Last and First boxes, type a last name and first name.

Note After you create the outline, the deponent is added as a character in the case.

• in the Type list, click a type of witness.

3. Under Outline, 

• in the Title box, type a title for the outline.

• in the Type list, click an outline type.

4. In the Comments box, type a comment, if desired.

5. Click OK.
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6. The outline is listed under Outlines in the left pane and displayed on a tab in the right pane 
(Figure 10-2).

Figure 10-2. Outline tab

Inserting Information into an Outline
To add information to an outline, you can type text in the outline or your can insert

• text from a document

• a report

• potential exhibits

• transcript questions

• a Westlaw document 

TYPING TEXT IN THE OUTLINE
You can type text directly in an outline. To format the text, use the icons on the toolbar above the 
outline or right-click in the outline and click Format on the menu.

INSERTING TEXT FROM A DOCUMENT
You can copy text from a document in Case Notebook and paste it into an outline. For further 
information, see ”Transferring Document Text” on page 106.

INSERTING A REPORT
You can insert an Annotations report, Issues report, Characters report, Full Text Search report, or Auto 
Tags report into an outline.

To insert a report into an outline, complete these steps:

1. Create a report.

1. Click Send on the toolbar above the report in the right pane, then click Outline on the menu. The 
Select Outline dialog box is displayed.

Note To insert only the questions from the report in the outline, if available, click Outline 
(Questions only) on the menu.

2. Click the outline in which you want to insert the report.
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3. Click OK. The report is displayed in the outline. To view the outline, click its tab in the right frame 
(Figure 10-3).

Figure 10-3. Outline with report

INSERTING POTENTIAL EXHIBITS
To insert links to potential exhibits in the outline, complete these steps:

1. Click in the outline where you want to insert the exhibits.

2. Click the Insert button ( ) on the toolbar above the outline, then click Insert Potential Exhibits 
on the menu. The Insert Potential Exhibits dialog box is displayed (Figure 10-4).

Figure 10-4. Insert Potential Exhibits dialog box

3. Click a document type, then select the check boxes next to the documents you want to include in 
the outline. 

4. Click Groups to include the data in a data group in your outline. The Data Groups dialog box is 
displayed. Select the group you want to include in the outline and click OK. The Insert Potential 
Exhibits dialog box is redisplayed.
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5. Click OK. A reference to each document is listed under the outline in the left pane and a link to 
each document is displayed in the outline in the right pane (Figure 10-5).

Figure 10-5. Outline with exhibits

INSERTING TRANSCRIPT QUESTIONS
You can insert transcript questions into an outline using the Insert feature or directly from a transcript 
using the Send feature.

Inserting Transcript Questions Using the Insert Feature

To insert transcript questions into an outline using the Insert feature, complete these steps:

1. Click the Insert button ( ) on the toolbar above the outline, then click Insert Transcript 
Questions on the menu. The Insert Transcript Questions dialog box is displayed (Figure 10-6).

Figure 10-6. Insert Transcript Questions dialog box

2. Click the transcript containing the questions you want to include in the outline. 

3. Select the Include answers check box, if desired.
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4. Click OK. A link to the transcript and the transcript questions are displayed in the outline 
(Figure 10-7). 

Figure 10-7. Outline with transcript questions

Inserting Transcript Questions Using the Send Feature

To insert transcript questions into an outline using the Send feature, complete these steps:

1. Access the transcript containing the questions you want to send to the outline.

2. Click the arrow next to the Annotate Mode button ( ) on the toolbar above the transcript in the 

right pane, then click the Copy button ( ) on the menu.

3. Select the text in the transcript that includes questions you want to send to the outline.

4. Right-click the selected text, point to Send, then click Outline (Questions only) on the menu. The 
Select Outline dialog box is displayed.

5. Select the outline to which you want to send the transcript questions and click OK. A link to the 
transcript and the transcript questions are displayed in the outline.

INSERTING A WESTLAW DOCUMENT
You can retrieve a document from the Witness Examination Outlines database (OUTLINES-ALL) on 
Westlaw and insert it into the outline on Case Notebook.

To insert a document from Westlaw, complete these steps:

1. Click in the outline where you want to insert the Westlaw document.
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2. Click the Insert button ( ) on the toolbar above the outline, then click Insert Westlaw Outline 
on the menu. The Search Westlaw dialog box is displayed (Figure 10-8).

Figure 10-8. Search Westlaw dialog box–Outlines tab

3. By default, the table of contents for OUTLINES-ALL is displayed on the Outlines tab. To search the 
OUTLINES-ALL database, 

• browse the table of contents by clicking the plus (+) and minus (–) symbols, then select the 
check box next to the document you want to retrieve.

• click Template to display a search template, then type your search terms in the boxes. For 
further information on formulating a search, see ”Working with Full Text Search” on page 98.

4. Click Search Westlaw. The Sign On with OnePass page is displayed. 

5. Type your OnePass username and password in the boxes. The client-matter information for the 
Case Notebook case is entered for you in the Client ID box. (To view the client-matter number for 
the case, on the File menu in Case Notebook, click Case Properties.)

6. Click Sign On to display the Westlaw search result.
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7. To send a document to Case Notebook, click the Export to Case Notebook icon ( ) in the upper-
right corner. The Export to Case Notebook page is displayed (Figure 10-9).

Figure 10-9. Export to Case Notebook dialog box

8. Click the Show arrow to add or remove a document element. Select or clear the check boxes for the 
elements you want to add or remove, then click the Hide arrow.

9. Make certain the matter number corresponds to the client-matter number for the case in Case 
Notebook. 

10. By default, the title of the document is entered for you in the Title box. Type a different title, if 
desired.

11. In the Recent Categories list, click an issue.

12. In the Comments box, type a comment, if desired.

13. Click Save. The Download Confirmation dialog box is displayed. 

14. Click Complete Download. The File Download dialog box is displayed. 

15. Click Open. The Research Files dialog box is displayed. 

16. Click Finish. The Select Outline dialog box is displayed.
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17. Select the outline in which you want to insert the document and click OK. The text of the document 
is displayed in the outline in the right pane (Figure 10-10).

Figure 10-10.  Outline with Westlaw document

Viewing Documents in an Outline
To view a list of the documents that you inserted in an outline, click Outlines in the left pane, then 
double-click the outline containing the documents.

To jump to the place in the outline where you inserted a document, double-click the document in the 
left pane. 

To view the source document, click the link for the document in the outline. The document is displayed 
in the right pane. 
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Printing an Outline
When you print an outline, you can also easily print the exhibits listed in the outline. To print an outline 
with listed exhibits, complete these steps:

1. Click the Print icon ( ) on the toolbar above the outline. The Print dialog box is displayed 
(Figure 10-11).

Figure 10-11. Print dialog box

2. In the Name list, click a printer.

3. To print the exhibits listed in your outline with annotations, under Exhibits–Annotated Work 
Product, type a number in the Number of Copies box.

Note You must select the Display Annotations check box on the Annotations tab if you want to 
print annotations in exhibits. For further information, see steps 9–15 below.

4. Select the Include blank page between exhibits check box, if desired.

5. Clear the Include header check box, if desired.

6. To print unannotated exhibits, under Exhibits–Originals, type a number in the Number of Copies 
box. 

7. Select the Include blank page between exhibits check box, if desired.

8. Click the Data tab to display all document types and data included in the outline. By default, all 
document types and data are selected. To exclude a document type from being printed, clear its 
check box. To exclude particular data from being printed, select the document type containing the 
data, then clear the check boxes for the data you want to exclude.

9. Click the Annotations tab.

10. By default, the Display Annotations check box is selected. This must be selected if you want to 
print annotations in the exhibits.

11. To include or remove annotations associated with specific issues from the printed documents, click 
Select Issues. The Select Issues dialog box is displayed. (Issues will be listed in this dialog box only 
if they have previously been created. See ”Working with Issues” on page 86.) Select or clear the 
check boxes next to the issues you want to include or remove and click OK. The Print dialog box is 
redisplayed.

12. Clear the Include Annotations with no Issues check box, if desired.

13. Clear the Display Annotations in footer check box, if desired.

14. In the Display list, click an option for how you want the annotations displayed in the transcript text.
Managing Outlines      77



15. Click OK.

Opening an Existing Outline 
To open an outline, complete these steps:

1. If necessary, click Outlines in the left pane to display a list of all outlines in the case.

2. Double-click the outline you want to open. The text of the outline is displayed in the right pane. 

Deleting an Outline 
To delete an outline, right-click the outline in the left pane and click Delete on the menu. The message 
Permanently delete the selected outline? is displayed. Click Yes.

Closing an Outline

To close an outline so that it is no longer displayed in the right pane, click the Close button ( ) on the 
outline’s tab.
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11 Working with Properties

The Properties dialog box for a transcript, document, pleading, or research document allow you to 

• view all properties at a single glance

• customize details

• add Doc-Level Issues

• add date and time values (document and pleading only)

• add the document to a data group

• add Doc-Level Notes

To access a Properties dialog box for a data type, right-click the document in the left pane and click 
Properties on the menu. By default, the Overview tab is displayed (Figure 11-1). 

Figure 11-1. Overview tab

You can quickly move to the next or previous item by clicking the Go to next or Go to previous arrow 
above the tabs, shown outlined in Figure 11-1.

Using the Overview Tab
The Overview tab in the Properties dialog box displays key Case Notebook properties pertaining to the 
document, including its details, Doc-Level Notes, issues, and data groups. When you click an item on 
the Overview tab, the appropriate tab is displayed where you can edit the information.

To add a Doc-Level Note on the Overview tab, click Add a Doc-Level Note. The Doc-Level Notes tab is 
displayed. For further information, see ”Adding Doc-Level Notes” on page 83.
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Editing Details
When you import a transcript, document, pleading, or research document, you can enter details, such 
as the title, during the import process. To edit the details, click the Details tab in the Properties dialog 
box (Figure 11-2). 

Figure 11-2. Details tab

Type the information in the appropriate boxes, then click OK.

Adding Doc-Level Issues
Case Notebook allows you to apply issues to

• selected text when you create an annotation. For further information, see ”Working with 
Annotations” on page 91. 

• the entire transcript, document, pleading, or research document when you create a Doc-Level 
Issue using the Properties dialog box.

In addition to allowing you to apply issues as a document property, Doc-Level Issues also provide a 
method of transferring issues applied to documents in other software products, such as Westlaw 
CaseLogistix. Therefore, when you import documents with issue coding from other products, those 
issues can be transferred into Case Notebook as Doc-Level Issues.
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To add an issue to your entire document, click the Doc-Level Issues tab (Figure 11-3), then select the 
check box for an issue in the dialog box or click Manage Issues to add or edit issues. For further 
information on managing issues, see ”Working with Issues” on page 86.

Figure 11-3. Doc-Level Issues tab

Doc-Level Issues are displayed in the following locations:

• the Overview tab in the Properties dialog box under Doc-Level Issues and Annotation Issues, 
shown outlined in Figure 11-5.

Figure 11-4. Doc-Level Issue on Overview tab

• the Doc-Level folder in the Annotations folder for the document, shown outlined in Figure 11-5. 
Double-click the issue to display the Doc-Level Issues tab in the Properties dialog box.

Figure 11-5. Doc-Level Issue in the Doc-Level folder
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Adding Dates
Click the Dates tab in the Properties dialog box to apply a variety of dates to your document or pleading 
(Figure 11-6).

Figure 11-6. Dates tab

Select the check box for the type of date you want to add to your properties. By default, the current date 
is entered for you. Type a different date in the box or click the arrow to display a calendar and click a 
date, if desired. 

When you select a date check box, you can add a time to the box by selecting the Set Time check box, if 
desired. By default, 12:00PM is entered for you. Type a different time, if desired.
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Adding Documents to a Group
You can quickly add your transcript, document, pleading, or research document to a data group using 
the Properties dialog box. To add a data type to a group, click the Data Groups tab, then select the 
check box for a group in the box (Figure 11-7).

Figure 11-7. Data Groups tab

To add or edit a data group, click Manage Groups. For further information, see ”Working with Data 
Groups” on page 104.

Adding Doc-Level Notes
Case Notebook allows you to add notes to

• selected text when you create an annotation. For further information, see ”Working with 
Annotations” on page 91.

• the entire transcript, document, pleading, or research document when you create Doc-Level Note 
using the Properties dialog box.

In addition to allowing you to apply a note as a document property, Doc-Level Notes also provide a 
method of transferring notes applied to documents in other software products, such as Westlaw 
CaseLogistix. Therefore, when you import documents with notes from other products, those notes can 
be transferred into Case Notebook as Doc-Level Notes.

Note You can include note text when you run a Full Text Search. 
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To add a Doc-Level Note using the Properties dialog box, complete these steps:

1. Click the Doc-Level Notes tab (Figure 11-8).

Figure 11-8. Doc-Level Notes tab

2. Click New. The New Doc-Level Note dialog box is displayed (Figure 11-9). 

Figure 11-9. New Doc-Level Note dialog box

3. Type a note in the box, then click OK. 

Doc-Level Notes are displayed in the following locations: 

• the Doc-Level Notes tab in the Properties dialog box.

• the Overview tab in the Properties dialog box under Doc-Level Notes.
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• the Doc-Level folder in the Annotations folder for the document in the left pane, shown outlined 
Figure 11-10. Double-click a note to display the Edit Doc-Level Note dialog box.

Figure 11-10. Doc-Level Notes in the Doc-Level folder
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12 Working with Issues 

An issue is a type of annotation that relates to a particular subject. Case Notebook allows you to apply 
issues to

• selected text when you create an annotation. For further information, see ”Working with 
Annotations” on page 91.

• an entire transcript, document, pleading, or research document. For further information, see 
”Adding Doc-Level Issues” on page 80.

Categorizing documents or annotations in a case by issue makes it easy to retrieve all information on a 
specific subject when you need it. Issues are created for each case and are the same for all users of that 
case. When creating new issues, it is important to not duplicate previous issues.

Although the issues in a case are the same for all users, each user can choose the issues to display on 
the Main Menu toolbar. The Main Menu toolbar enables you to access issues quickly when creating 
annotations. You can display up to 10 issues on the Main Menu toolbar. 

Creating Issues 
To create an issue, complete these steps: 

1. On the Main Menu toolbar, click the Manage Issues button ( ). The Manage Issues dialog box is 
displayed (Figure 12-1).

2. Click New to display the New Issue dialog box.

3. In the Issue box, type a name for the issue, e.g., Work history. 

4. Click the Color arrow to select a different color for the issue, if desired.

5. Click Repeat if you are creating multiple issues. 

6. When you finish creating issues, click OK in the New Issue dialog box. The issues are listed under 
All Issues in the Manage Issues dialog box.

Figure 12-1. Manage Issues dialog box

CREATING SUB-ISSUES 
You can create sub-issues, which are a subset of existing issues.You can add up to three levels of sub-
issues. 
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To create a sub-issue, complete these steps:

1. On the Main Menu toolbar, click the Manage Issues button ( ). The Manage Issues dialog box is 
displayed.

2. Click the # button ( ), if it is not already selected, to display numbers next to the issues 
(Figure 12-2).

Figure 12-2. Manage Issues dialog box

3. Under All Issues, click the issue, e.g. Work history, for which you want to create a sub-issue.

Note If you do not select an issue, the sub-issue is added to the bottom of the list. 

4. Click New to display the New Issue dialog box.

5. In the Issue box, type a name for the sub-issue, e.g., Missed work. 

6. Click the Color arrow to select a different color for the issue, if desired.

7. Click Repeat if you are creating multiple sub-issues. 

8. When you finish creating sub-issues, click OK in the New Issue dialog box. The sub-issues are listed 
under the issue you selected.

9. Click the sub-issue, if necessary, then click the Increase Indent button ( ). The sub-issue is 
indented under the issue and the sub-issue number becomes sequential to the issue number. 

To remove the sub-issue from under the issue, click the Decrease Indent button ( ).

Adding Issues to the Toolbar
To prioritize an issue or sub-issue and add it to the Main Menu toolbar, complete these steps: 

1. On the Main Menu toolbar, click the Manage Issues button. The Manage Issues dialog box is 
displayed.

2. Click an issue or sub-issue under All Issues, e.g., Work history. 

3. Click the left arrow to move the issue or sub-issue under My Top Issues.

4. Repeat steps 2 and 3 for each issue or sub-issue you want to prioritize and add to the Main Menu 
toolbar. You can prioritize up to 10 issues and sub-issues (Figure 12-3). 

5. To reprioritize an issue or sub-issue and change its order on the Main Menu toolbar, select the 
issue or sub-issue under My Top Issues and click the up arrow or down arrow.
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6. Click OK when you finish prioritizing the issues or sub-issues. 

Figure 12-3. Prioritizing issues

Importing Issues
You can create a list of issues in any word-processing program that can save files as XML (Extensible 
Markup Language) files. To import issues and sub-issues from a file, complete these steps: 

1. On the Main Menu toolbar, click the New arrow, then click Issues (from File) on the menu. The 
Open dialog box is displayed. 

2. Click the file containing the issues you want to import and click Open. 

3. The message Issues were successfully imported from the chosen file is displayed. Click OK. 

Exporting Issues
To export issues to a file, complete these steps: 

1. On the File menu, point to Save As and click Issues. The Save As dialog box is displayed. 

2. Click a location for the file.

3. In the File name box, type a name for the file. 

4. In the Save as type list, click a file type.

5. Click Save. 
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Creating an Issues Report 
This report lists all of the issues in a document, grouped by issue and then arranged in page and line 
order. To create an Issues report, complete these steps: 

1. On the Main Menu toolbar, click the Report button ( ), then click Issues on the menu. The 
Issues Report Properties dialog box is displayed (Figure 12-4). 

Figure 12-4. Issues Report Properties dialog box 

2. On the Issues tab, 

• all of the issues in the case are selected by default. To remove an issue from the report, clear its 
check box.

• select the Include Annotations or Doc-Level Notes with no Issues check box, if desired.

• select the Only include Annotations with all selected issues (“Match all Issues”) check box, if 
desired.

• select the Only include results that contain Annotation Notes or Doc-Level Notes check box, if 
desired.

3. Click the Data tab to display a list of all document types and data. By default, all document types 
and data are selected. To exclude a document type from the report, clear its check box. To exclude 
particular data from the report, click the document type containing the data, then clear the check 
boxes for the data you want to exclude. 

4. Click the Display tab to view a list of display options. You can

• in the Title box, type a title for the report, if desired. 

• in the Sort By list, click an option.

• select or clear the appropriate check boxes. 

• select the Include cover page when printing or saving check box, if desired.

5. Click the Context tab to display a list of context options. Select or clear the appropriate check 
boxes. 

6. Click the Authors tab to display a list of annotation authors. If you are working in a secure case on a 
network, a list of all annotation authors is displayed. If you are working in the case offline, only 
LocalUser is displayed. Select or clear the appropriate check boxes.
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7. Click OK. The Issues report, which includes the lines you marked and the surrounding questions 
and answers, is listed under Report in the left pane and the text of the report is displayed on the 
Report tab in the right pane (Figure 12-5).

Figure 12-5. Issues report

When viewing the report, you can

• click the heading next to a document icon in the report to go to the location in the document where 
the issue appears.

• click the Hit arrows in the left pane to view the next or previous issue in the report. 

• click the Sort by arrow in the left pane to sort your report.
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13 Working with Annotations 

An annotation is a highlighted portion of document text. It may be associated with an issue; a note (a 
comment associated with an annotation); or an attachment, e.g., a document or image. Annotations 
are contained in the Annotations folder under the document in the left pane (Figure 13-1). Click the plus 
(+) and minus (–) symbols to view the annotations. Double-click an annotation to jump to the 
annotation in the transcript.

Figure 13-1. Annotations

By default, annotations are grouped by issue, as shown in Figure 13-1. To change how annotations are 
displayed, on the View menu, click Display Options. On the General tab in the Display Options dialog 
box, clear the Group Annotations by Issue check box.

Adding an Issue Annotation Using the Apply Issue Mode Button 
To add an annotation associated with an issue using the Apply Issue Mode button on the Main Menu 
toolbar, complete these steps: 

1. Make certain the Apply Issue Mode button ( ) is displayed on the toolbar above the document 

in the right pane. To display the Apply Issue Mode button, click the Annotate Mode button ( ) 
on the toolbar above the document, then click Apply Issue Mode on the menu. 

Note The Annotate Mode button is the default button.

2. On the Main Menu toolbar, click an issue button to select the issue and assign it to the annotation 
you are adding. 

3. Select the text you want to annotate. The text is highlighted with the color of the issue you selected 
(Figure 13-2). The issue will be assigned to every annotation you create until you cancel its 
selection on the Main Menu toolbar. 
Working with Annotations      91



ply Issue 
de button
Note You can select more than one issue on the Main Menu toolbar. Annotated text will be highlighted 
with the color of the last issue that you select. 

Figure 13-2. Annotated text

Adding an Annotation Using the Annotation Properties Dialog Box
You can use the Annotation Properties dialog box to add an annotation associated with a note, issue, 
key fact, attachment, or a combination of these. To view the Annotation Properties dialog box, make 
certain the Annotate Mode button ( ) is displayed on the toolbar above the document in the right 
pane. Then select the text in document you want to annotate. The Annotation Properties dialog box is 
displayed (Figure 13-3). 

Figure 13-3. Annotation Properties dialog box 

ADDING A NOTE TO AN ANNOTATION
The Note tab is the default tab in the Annotation Properties dialog box. To add a note to the annotated 
text, in the Note box, type a note and click OK.

ADDING AN ISSUE TO AN ANNOTATION
To associate an issue with an annotation, complete these steps: 

1. Click the Issues tab in the Annotation Properties dialog box. A list of prioritized issues (those that 
appear on the Main Menu toolbar) is displayed under My Top Issues and a list of all issues is 
displayed under All Issues. 

2. To assign one or more issues to the annotation, select the appropriate check boxes. Note that the 
check boxes for any issues you previously selected on the Main Menu toolbar are already selected. 

3. Click OK. The annotated text is highlighted with the color of the issue you selected.

Ap
Mo
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ADDING A KEY FACT TO AN ANNOTATION
To assign a key fact to an annotation, click the Key Facts tab in the Annotation Properties dialog box, 
select the key fact you want to assign to the annotation, and click OK.

ADDING AN ATTACHMENT TO AN ANNOTATION
To add an attachment to an annotation, complete these steps:

1. Click the paper clip icon ( ) in the Annotation Properties dialog box. The Edit Attachment dialog 
box is displayed.

2. Click Browse to display the Open dialog box is. Select your document and click Open. The Edit 
Attachment dialog box is redisplayed.

3. Click OK.

4. Click OK again in the Annotations Properties dialog box. For transcripts, a paper clip icon is 
displayed next to the annotation (Figure 13-4). To view the attachment, click the paper clip icon.

Figure 13-4. Paper clip icon in a transcript

ASSOCIATING VIDEO WITH AN ANNOTATION 
You can associate video with an annotation if the transcript has been synchronized with video footage. 
For further information, see ”Working with Video in Transcripts” on page 118.

Transferring Annotations 
You can transfer an annotation to another application such as Microsoft Word, Corel WordPerfect, or 
TrialDirector using either of the following methods:

• Click Send in the Annotation Properties dialog box, then click the application on the menu. 

• Right-click in the annotation, point to Send on the menu, then click the application on the 
submenu.

To transfer an annotation that is associated with a video to PowerPoint, see ”Transferring Annotations 
to Microsoft PowerPoint” on page 119.

Sending Annotations to Instant Messages
To send an annotation to a team member during an instant messaging session when using LiveNote 
Realtime, complete these steps:

1. Click Send in the Annotation Properties dialog box, then click Realtime Chat on the menu.

2. Click OK. The annotation is displayed in the Annotation box under Stream in the left pane. 

3. Click Send to send the annotation to your chat group. Or click an individual in the Send To list and 
click Send. 
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4. Repeat steps 1–3 for each annotation you want to send (Figure 13-5).

Figure 13-5. Sending an annotation to an instant message

Editing Annotations 
To change the information associated with an annotation, right-click in the annotation and click Edit 
Annotation on the menu. The Annotation Properties dialog box is displayed. Make the appropriate 
changes and click OK.

Deleting Annotations 
To delete an annotation, right-click in the annotation and click Delete Annotation on the menu. The 
message Permanently delete the selected Annotation? is displayed. Click Yes. 

Viewing an Annotation Attachment 
To view an annotation attachment, right-click in the annotation and click Open Attachment on the 
menu. 

Creating an Annotations Report 

CREATING AN ANNOTATIONS REPORT FOR THE DOCUMENT YOU ARE VIEWING
You can generate a report that includes a list of all the annotations in a document, arranged in page 
and line order. It also includes the surrounding questions and answers. 
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To create an Annotations report for the document you are viewing, right-click the Annotations folder in 
the left pane and click Report. The report is listed under Report in the left pane and the text of the 
report is displayed on the Report tab in the right pane (Figure 13-6). 

Figure 13-6. Annotations report

When viewing the report, you can

• click the heading next to a document icon in the report to go to the location in the document where 
the annotation appears.

• click the Hit arrows in the left pane to view the next or previous annotation in the report. 

• click the Sort by arrow in the left pane to sort your report.
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CREATING AN ALL ANNOTATIONS REPORT

To create an Annotations report for one or more documents, complete these steps: 

1. On the Main Menu toolbar, click the Report button ( ), then click All Annotations on the 
menu. The All Annotations Report Properties dialog box is displayed (Figure 13-7). 

Figure 13-7. All Annotations Report Properties dialog box

2. On the Issues tab, 

• all of the issues in the case are selected by default. To exclude an issue from the report, clear its 
check box.

• clear the Include Quick Marks check box, if desired.

• clear the Include Annotations or Doc-Level Notes with no Issues check box, if desired.

• select the Only include Annotations with all selected issues (“Match all Issues”) check box, if 
desired.

• select the Only include results that contain Annotation Notes or Doc-Level Notes check box, if 
desired.

3. Click the Data tab to display a list of all document types and data. By default, all document types 
and data are selected. To exclude a document type from the report, clear its check box. To exclude 
particular data from the report, click the document type containing the data, then clear the check 
boxes for the data you want to exclude. 

4. Click the Display tab to view a list of display options. You can

• in the Title box, type a title for the report, if desired. 

• in the Sort By list, click an option.

• select or clear the appropriate check boxes. 

• select the Include cover page when printing or saving check box, if desired.

5. Click the Context tab to display a list of context options. Select or clear the appropriate check 
boxes. 

6. Click the Authors tab to display a list of annotation authors. If you are working in a secure case on a 
network, a list of all annotation authors is displayed. If you are working in the case offline, only 
LocalUser is displayed. Select or clear the appropriate check boxes.
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7. Click OK. The Annotations report, which includes the lines you marked and the surrounding 
questions and answers, is listed under Report in the left pane and the text of the report is displayed 
on the Report tab in the right pane. 

Figure 13-8. All Annotations Report

When viewing the report, you can

• click the heading next to a document icon in the report to go to the location in the document where 
the annotation appears.

• click the Hit arrows in the left pane to view the next or previous annotation in the report. 

• click the Sort by arrow in the left pane to sort your report.

CREATING A VERBATIM SUMMARY REPORT 
This is an Annotations report that includes only highlighted transcript text. To create a Verbatim 
Summary report, first create an Annotations report. Then click the Properties button ( ) on the 
toolbar above the report to display the All Annotations Report Properties dialog box. Click the Display 
tab and clear all check boxes under Annotations. Then, click the Context tab. Under Transcripts, select 
the Show annotated text check box and clear the Additional context check box, then click OK.

CREATING A NOTES REPORT 
This report lists all of the annotations in a document that have a note, arranged in page and line order. 
To create a Notes report, first create an Annotations report. Then click the Properties button ( ) 
on the toolbar above the report to display the All Annotations Report Properties dialog box. On the 
Issues tab, select the Only include results that contain Annotation Notes or Doc-Level Notes check 
box and click OK.

CREATING AN ATTACHMENTS REPORT 
This report lists all of the annotations in a document that have an attachment, arranged in page and 
line order. To create an Attachments report, first create an Annotations report. Then click the 
Properties button ( ) on the toolbar above the report to display the All Annotations Report 
Properties dialog box. On the Issues tab, clear the Include Quick Marks check box. Then click the 
Display tab. Clear all check boxes under Annotations except the Attachment check box, then click OK.
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14 Working with Full Text Search 

The Full Text Search feature enables you to search one or more documents in the open case for specific 
terms. 

Creating a Full Text Search 
You can enter a search that consists of key terms from your issue and connectors specifying the 
relationship between those terms. To create a search, complete these steps: 

1. On the Search menu, click Full Text Search. The Full Text Search Properties dialog box is displayed 
(Figure 14-1).

Figure 14-1. Full Text Search Properties dialog box

2. Formulate your search by choosing search terms significant to your issue and deciding which 
connectors to place between your terms. To retrieve variations of terms, use the root expander (!) 
and the universal character (*). To retrieve a phrase, place quotations marks (“ ”) around the 
phrase. 

For more information on creating a search, see ”Formatting a Full Text Search” on page 100.

3. In the Terms box, type your search, e.g., document /20 handwritten. Or click a search in the 
Recent list. 

4. Click the Data tab to display all document types and data. By default, all document types and data 
are selected, including the text of Doc-Level Notes. To exclude a document type from the search, 
clear its check box. To exclude particular data from your search, click the document type 
containing the data, then clear the check boxes for the data you want to exclude.

5. Click Groups to include a group in your search, if desired.
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6. Click OK. Information about the search is displayed under Search Results in the left pane 
(Figure 14-2). 

Figure 14-2. Full Text Search result

To work with your search result, you can

• click a line in the result list to display that place in the result

• click Edit ( ) to edit your search

• click Report ( ) to create a report for your search result

• click the Term ( ) arrows to view the next or previous search term in your result

• click the Sort by arrow to sort your search result (Figure 14-3)

Figure 14-3. Sort by list
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Formatting a Full Text Search 

USING THE ROOT EXPANDER
Use the root expander (!) to retrieve words with variant endings. The root expander must always be 
placed at the end of a term. For example, 

Plurals and possessive forms are automatically retrieved without a root expander.

USING THE UNIVERSAL CHARACTER
Use the universal character (*) to represent one variable character. You can place the universal 
character anywhere in a term except at the beginning. For example,

Note When you place one or more universal characters at the end of a term, you specify the maximum 
length of that term.

USING CONNECTORS
Use connectors to specify the relationships that should exist between search terms in your retrieved 
documents. 

Creating a Search Report 
This report lists the result retrieved when you run a search using the Full Text Search feature. To create 
a Search report, on the Main Menu toolbar, click the Report button ( ), then click Full Text 
Search on the menu. See ”Working with Full Text Search” on page 98 for information on running 
searches. 

Type To retrieve

contribut! contribute
contributed
contributor
contributing
contribution
contributory

Type To retrieve

gr*w grew
grow

Type To search for documents that contain

& (AND) both terms

a space (OR) either term or both terms

/n terms within n terms of each other (where n is a number)

+n the first term preceding the second by n terms (where n is a number)

“ ” terms appearing in the same order as in the quotation marks

Type To exclude documents that contain

% (BUT NOT) the terms following the percent symbol
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15 Working with Auto Tags

Use Auto Tags to automatically highlight words or phrases as they appear in a document.

Creating Auto Tags 
To create an Auto Tag, complete these steps: 

1. On the Annotate menu, click Auto Tags. The Auto Tags dialog box is displayed (Figure 15-1). 

Figure 15-1. Auto Tags dialog box

2. Click New. Then type the word or phrase you want to add to the Auto Tags list. 

3. Select the Show Auto Tags check box to highlight Auto Tags in the document. 

4. Click the Color arrow to select a color, if desired. 

5. Click OK to save your changes. Your Auto Tags will be highlighted automatically throughout the 
document (Figure 15-2). 

Figure 15-2. Auto Tags

Managing Auto Tags 

SHOWING AND HIDING AUTO TAGS 
If you choose not to show Auto Tags when you create them, on the Annotate menu, click Auto Tags. The 
Auto Tags dialog box is displayed. Select the Show Auto Tags check box and click OK. To hide Auto Tags, 
clear the Show Auto Tags check box. 
Working with Auto Tags      101



DELETING AUTO TAGS 
To delete an Auto Tag, complete these steps: 

1. On the Annotate menu, click Auto Tags to display the Auto Tags dialog box. 

2. Select the Auto Tag you want to remove and click Delete. 

3. Repeat step 2 for each Auto Tag you want to delete. 

4. Click OK to save your changes. 

Creating an Auto Tag Report 
This report lists all occurrences of the words and phrases in a transcript for which Auto Tags were 
created, arranged in page and line order. To create an Auto Tag report, complete these steps:

1. On the Main Menu toolbar, click the Report button ( ), then click Auto Tags on the menu. 
The Auto Tag Report Properties dialog box is displayed (Figure 15-3). 

Figure 15-3. Auto Tag Report Properties dialog box 

2. Click the Data tab to display a list of all document types and data. By default, all document types 
and data are selected. To exclude a document type from the report, clear its check box. To exclude 
particular data from the report, click the document type containing the data, then clear the check 
boxes for the data you want to exclude. 

3. Click the Display tab to view a list of display options. You can

• in the Title box, type a title for the report, if desired. 

• in the Sort By list, click an option.

• select or clear the appropriate check boxes. 

• clear the Highlights check box, if desired.

• select the Include cover page when printing or saving check box, if desired.

4. Click the Context tab to display a list of context options. Select or clear the appropriate check 
boxes. 
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5. Click OK. The Auto Tag report, which includes the lines with the Auto Tags and the surrounding 
questions and answers, is listed under Report in the left pane and the text of the report is displayed 
on the Report tab in the right pane (Figure 15-4).

Figure 15-4. Auto Tag report

When viewing the report, you can

• click the heading next to a document icon in the report to go to the location in the document where 
the Auto Tag appears.

• click the Hit arrows in the left pane to view the next or previous Auto Tag in the report. 

• click the Sort by arrow in the left pane to sort your report.
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16 Working with Data Groups 

You can organize document types and data into groups and sub-groups. For example, you can create 
groups based on the different types of witnesses in a case, such as character witnesses and expert 
witnesses. When you assign data to a group, the data is displayed under the group folder in the left 
pane (Figure 16-1). You can also select a group when you are preparing reports or creating searches to 
ensure all the document types and data you need are included. 

Figure 16-1. Documents organized into data groups

Creating a Data Group 
To create a data group, complete these steps: 

1. On the Main Menu toolbar, click the New arrow, then click Data Group on the menu. The Manage 
Data Groups dialog box is displayed (Figure 16-2). 

Figure 16-2. Manage Data Groups dialog box

2. Click the New button on the toolbar.

3. Type the name of the group, e.g., Plaintiff Expert Witnesses.
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Note To create a sub-group for a group, click the group name, then click the New button on the 
toolbar and type the name for the sub-group under the group.

4. Click a data type in the center pane, then select the check boxes for the data you want to include in 
the group or sub-group. If you select the check box for the data type, all data items are 
automatically selected.

5. Click OK. 

Editing Data Groups 
To add document types and data to a group or remove them from a group, complete these steps: 

1. On the Tools menu, click Manage Data Groups. The Manage Data Groups dialog box is displayed. 

2. Select the group you want to edit. You can

• click the Rename button on the toolbar, then type a new name for the group.

• select or clear the appropriate check boxes for the data you want to include or exclude. 

3. Click OK. 

Using Data Groups in Reports 
To create a report using data groups, complete these steps: 

1. On the Main Menu toolbar, click the Report button ( ), then click the type of report you 
want to create, e.g., Issues. 

2. In the Properties dialog box that is displayed, click the Data tab, then click Groups. The Select Data 
Groups dialog box is displayed. 

3. Select the group or groups you want to include in the report and click OK. 

4. Click OK again to create the report. 

Using Data Groups in Full Text Searches 
You can run full text searches using data groups. To conduct a search using data groups, complete 
these steps: 

1. On the Search menu, click Full Text Search. The Full Text Search Properties dialog box is 
displayed. 

2. In the Terms box, type a search, or click a search in the Recent list.

3. Click the Data tab, then click Groups. The Select Data Groups dialog box is displayed.

4. Select the group or groups you want to include in the search and click OK. The Full Text Search 
Properties dialog box is redisplayed.

5. Click OK to run the search.

See ”Working with Full Text Search” on page 98 for more information on using the Full Text Search 
feature.

Sorting by Data Groups
Use the Sort by Data Groups feature to view transcripts, documents, pleadings, and research 
documents sorted by data groups. For example, to view documents listed in the data groups, click 
Documents in the left pane, then click the Sort By and click Sort By Data Groups on the menu. The 
documents are listed in the data group folders to which they were assigned.
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17 Transferring Document Text

You can copy text or a portion of a document and paste it into an outline in Case Notebook or other 
applications. For each document type, you will need to make certain that the appropriate button used 
for copying text is displayed. To display a button, click the Annotate Mode button ( ) on the toolbar 
above the document in the right pane, then click the appropriate button from the menu (Figure 17-1), as 
discussed below. The menu choices will vary depending on the document type you are viewing.

Figure 17-1. Copy buttons

Transferring Text of a Transcript
When viewing a transcript, you can transfer the transcript citation with the text, which includes the 
following details:

• name of the transcript

• page number (or numbers if copied text spans more than one page) 

• line numbers 

• date of the transcript

To transfer transcript text with the transcript citation, complete these steps: 

1. Make certain the Copy (with Page and Line) button ( ) is displayed. 

2. Select the text you want to copy. 

3. Open an outline in Case Notebook or open another application and paste the text you have copied. 
For example, to paste the text into Microsoft Word, press Ctrl+V or click Paste on the Edit menu in 
Word (Figure 17-2).

Figure 17-2. Transcript text with citation in Word

Transferring Text of a Document or Pleading
To transfer the text of a document or pleading that is a word-processing document, complete these 
steps:

1. Make certain the Copy button ( ) is displayed. 

2. Select the text you want to copy. 
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3. Open an outline in Case Notebook or open another application and paste the text you have copied. 
For example, to paste the text into Microsoft Word, press Ctrl+V or click Paste on the Edit menu in 
Word.

If you are viewing a document or pleading that is an image file or PDF file, you can transfer a portion of 
the document or pleading. To transfer a portion of a document or pleading, complete the following 
steps:

1. Make certain the Select Mode button ( ) is displayed. 

2. Select the portion of the document you want to copy. 

3. On the Edit menu, click Copy.

4. Open an outline in Case Notebook or open another application and paste the text you have copied. 

Transferring Text of a Research Document
If you are viewing a Westlaw document, you can transfer the citation with the text. To transfer text with 
its citation, complete these steps:

1. Make certain the Copy (with Citation) button ( ) is displayed. 

2. Select the text you want to copy. 

3. Open an outline in Case Notebook or open another application and paste the text you have copied. 
For example, to paste the text into Microsoft Word, press Ctrl+V or click Paste on the Edit menu in 
Word.
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18 Using the Word Index 

The Word Index contains an index of words and numbers in a document along with their corresponding 
page and line numbers (Figure 18-1). When you are connected to a real-time session, the Word Index is 
updated every 15 seconds. Use the Word Index to search for a term in the document. Type the term in 
the box to the right of the document to display the pages and lines where the term is found in the 
document. 

To see the term in context, point to the page and line reference. The question and answer in which the 
term appears is displayed. 

Note If you do not see the question and answer in which the term appears, you must change the Word 
Index display options. For further information, see “Selecting Word Index Display Options” 
below.

To display the term in the document, click the page and line reference. 

Figure 18-1. Word Index

Selecting Word Index Display Options
To select Word Index display options, on the View menu, click Display Options. The Display Options 
dialog box is displayed. Click the Word Index tab ((Figure 18-2). You can specify 

• whether you want to see your term in context when you point to the page and line reference in the 
Word Index

• how much document text you want displayed when viewing a term in context in the Word Index. If 
you select QA Pair, the entire question and answer in which the term appears is displayed. In the 
alternative, you can designate the number of lines to be displayed above and below the term 

• the types of documents in which to display the Word Index 

In the Word Index box, type 
the term you want to find.

Point to the page and line 
reference to see your term in 
context.
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Click OK to save the Word Index display options.

Figure 18-2. Display Options dialog box
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19 Connecting to LiveNote Realtime 

You can connect to a LiveNote Realtime session using

• a serial connection

• LiveNote Stream via Westlaw Case Notebook or Microsoft Internet Explorer

• your local network using an Ethernet cable or wireless connection

Connecting with a Serial Connection 
If you want to connect to LiveNote Realtime using serial cables, your computer must have a serial port. 
If you have only a USB port available, you will need to provide a USB to serial adapter. (For information 
about serial adapters, download a free copy of Connecting to LiveNote Realtime at store.westlaw.com
/support/user-guide/livenote-case-notebook.aspx.) Contact the court reporter to schedule the session. 

To connect to LiveNote Realtime using serial cables, complete these steps: 

1.  On the Main Menu toolbar, click the New arrow, then click Realtime Transcript on the menu. The 
Connect to Realtime dialog box is displayed (Figure 19-1). 

Figure 19-1. Connect to LiveNote Stream dialog box

2. Select Serial. The court reporter will give you the necessary settings for connecting to the reporter’s 
CAT system. You will need to know the required serial port setting. 

3.  Click Connect. 

Using LiveNote Stream 
LiveNote Stream allows you to connect to LiveNote Realtime via the Internet. You can access LiveNote 
Stream through Case Notebook software or Internet Explorer. 

The court reporter must schedule the session 24 hours in advance if you want to use LiveNote Stream to 
view transcript text or 72 hours in advance to view video and text. LiveNote Central will send you an 
email with the required username and password. 

Note In order to view the video segment, you must use Internet Explorer and Windows Media Player 9 
or later. You must also unblock pop-up windows. 
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ACCESSING LIVENOTE STREAM THROUGH CASE NOTEBOOK
To connect to LiveNote Stream through Case Notebook, complete these steps: 

1. On the Main Menu toolbar, click the New arrow, then click Realtime Transcript on the menu. The 
Connect to Realtime dialog box is displayed (Figure 19-2). 

Figure 19-2. Connect to LiveNote Stream dialog box

2. Select LiveNote Stream. 

3. Select the Play live video (if available) check box.

4. Click Connect. The LiveNote Stream Login dialog box is displayed. 

5. Type the username and password sent to you by LiveNote Central and click OK. The Connect to 
LiveNote Stream dialog box is displayed. 

6. Select the session you want to attend and click OK. 

ACCESSING LIVENOTE STREAM THROUGH INTERNET EXPLORER 
You do not need Case Notebook software to access LiveNote Stream through Internet Explorer. 

To access LiveNote Stream through Internet Explorer, complete these steps: 

1.  Go to www.livenote.com/stream.

2.  Type the username and password sent to you by LiveNote Central and click Go to display a list of 
your sessions. 

3.  Select the session you want to attend and click Go. The Realtime transcript text and video are 
displayed (Figure 19-3). 

Figure 19-3. LiveNote Stream session via Internet Explorer
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ACCESS TO FEATURES IN LIVENOTE STREAM 
When you view access LiveNote Stream using Internet Explorer, you are able to hear the audio and see 
the video and streaming transcript text. You can also stop and start the transcript text. When you 
access LiveNote Stream using Case Notebook software, you have access to all the tools in Case 
Notebook. Below is a chart showing the features available with LiveNote Stream.

Using LiveNote Local Stream
Case Notebook provides the ability to connect to LiveNote Realtime using an Ethernet cable or a 
wireless router. The court reporter will provide a username, password, and the server IP address for 
each participant to log in to the session.

To connect to LiveNote Stream using your local network, complete these steps: 

1.  On the Main Menu toolbar, click the New arrow, then click Realtime Transcript on the menu. The 
Connect to Realtime dialog box is displayed (Figure 19-4). 

Figure 19-4. Connect to LiveNote Stream dialog box

Case Notebook 
Features

LiveNote Stream
Through Internet Explorer

LiveNote Stream
Through Case Notebook

Audio

Video

Instant messaging

Streaming transcript text

Start and stop text

Word Index

Saved transcript

Quick Marks

Issue Marks

Annotations

Auto Tags

Full Text Search

Reports
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2. Select LiveNote Local Stream. 

3. In the Server IP box, type the server IP address provided by the court reporter. 

Note You can click Find to retrieve the server IP address once the session has started, if necessary.

4. In the Server Port box, type the server port number.

5.  Click Connect. The LiveNote Stream Login dialog box is displayed.

6. Type the username and password provided by the court reporter in the appropriate boxes.

7. Click OK.

Working with Realtime Refresh
The Realtime Refresh feature allows the court reporter to make corrections to a transcript during a 
LiveNote Realtime session and for the participants to view those corrections in real time. If you are 
participating in a LiveNote Realtime session and are connected using LiveNote Stream or LiveNote 
Local Stream, the Realtime Refresh feature works automatically. If you are participating in a session 
using a serial connection, in the Connect to Realtime dialog box, after clicking Serial, in the CAT Output 
list, click Bridge. 

Figure 19-5. Connect to Realtime dialog box

To use Realtime Refresh, the court reporter must be using CAT software that utilizes Bridge refresh 
protocol. Bridge is auto-refresh technology made available by some CAT software makers, such as 
Eclipse. As a participant, you must have Case Notebook 3.0 or later installed on your computer.
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20 Working with a Transcript in 
LiveNote Realtime 

Case Notebook provides you with tools that are easy to use even when you are working with a transcript 
in LiveNote Realtime. You can stop and start the scrolling text, annotate the text, and do quick word 
searches at the same time that you are listening to what the deponent or witness is saying. You can also 
annotate and search existing transcripts. 

Starting and Stopping Text 
To stop the scrolling transcript (Figure 20-1),

• click Pause on the toolbar above the transcript

• press the Esc key

To browse the text of the transcript,

• use the scroll bar on the right

• press the Page Up and Page Down keys

• press the arrow keys

• press Ctrl+Home to go to the top of the text

• press Ctrl+End to go to the end of the text

To restart the scrolling transcript,

• click Pause

• press the Esc key 

Figure 20-1. Starting and stopping transcript text

Using Quick Marks 
Quick Marks are marks at the line number in the margin of a transcript. They are the simplest form of 
annotation in Case Notebook and are displayed as a solid bar in the default Quick Mark color. You can 
use them as place markers in the text for which you can run searches and generate reports. 

To insert a Quick Mark (Figure 20-2)

• press the spacebar on your keyboard 

• click a line number 

Quick Marks are located in the Unassigned folder within the Annotations folder under the transcript in 
the left pane. Click the plus symbol (+) next to the transcript to view the Annotations folder, then click 

To stop the scrolling text, click Pause or 
press the Esc key. To restart the scrolling
text, click Pause or press the Esc key 
again

Use the scroll bar to browse the text of 
the transcript.
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the plus symbol next to the Unassigned folder to view the Quick Marks. Double-click a Quick Mark 
reference in the folder to jump to the Quick Mark in the transcript. 

To delete a Quick Mark, click it in the margin of the transcript. 

Figure 20-2. Quick Mark

Quick Marks Report 
This report lists all Quick Marks and Issue Marks in a transcript, arranged in page and line order. 

To create a Quick Marks report for the transcript you are viewing, click the Quick Mark Report button 
( ) on the toolbar above the transcript in the right pane. The report is displayed on the 
Report tab in the right pane. 

To create a Quick Marks report for one or more transcripts, complete these steps:

1. On the Main Menu toolbar, click the Report button ( ), then click Quick Marks on the 
menu. The Quick Mark Report Options dialog box is displayed (Figure 20-3).

Figure 20-3. Quick Mark Report Options dialog box

2. All of the issues in the case are selected on the Issues tab by default. To exclude an issue from the 
report, clear its check box.

3. Click the Data tab to display a list of transcripts. By default, all transcripts are selected. To exclude 
a transcript from the report, clear its check box.

4. Click the Display tab to view a list of display options. You can
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• in the Title box, type a title for the report, if desired. 

• in the Sort By list, click an option.

• select or clear the appropriate check boxes. 

• select the Include cover page when printing or saving check box, if desired. 

5. Click the Context tab to display a list of context options. Select or clear the appropriate check 
boxes. 

6. Click the Authors tab to display a list of annotation authors. If you are working in a secure case on a 
network, a list of all annotation authors is displayed. If you are working in the case offline, only 
LocalUser is displayed. Select or clear the appropriate check boxes.

7. Click OK. The Quick Marks report, which includes the lines you marked and the surrounding 
questions and answers, is displayed on the Report tab in the right pane (Figure 20-4). 

Figure 20-4. Quick Marks report

When viewing the report, you can

• click the heading next to a document icon in the report to go to the location in the document where 
the Quick Mark appears.

• click the Hit arrows in the left pane to view the next or previous Quick Mark in the report. 

• click the Sort by arrow in the left pane to sort your report.

Using Issue Marks 
An Issue Mark is a mark at the page and line number in the margin of a transcript that corresponds to a 
particular issue on the Main Menu toolbar. The Issue Mark color is the same as the color of the issue. To 
insert an Issue Mark, on the Main Menu toolbar, click an issue button, then click a line number (Figure 
20-5). 

Issue Marks are displayed with their associated issue in the Annotations folder in the left pane. Click the 
plus symbol (+) next to the transcript to view the Annotations folder, then click the plus symbol next to 
the issue to view the Issue Mark. Double-click an Issue Mark reference in the folder to jump to the Issue 
Mark in the transcript. 
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To delete an Issue Mark, click it in the margin of the transcript. 

Figure 20-5. Issue Mark

On the Main Menu 
toolbar, click an issue 
button, then click a line 
number to place an Issue 
Mark in the margin of the 
transcript.

Double-click an Issue 
Mark reference to jump 
to its location in the 
transcript.
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21 Working with Video in Transcripts

Playing Video Segments 
If the transcript you are viewing has a video associated with it, you can view the portion of the video that 
is synchronized with the transcript. To view the video, right-click anywhere in the transcript, then click 
Play Video. To play a video segment that is associated with an annotation, right-click in the annotation 
and click Play Video Segment on the menu.

Creating Annotation Video Segments 
If a transcript has been synchronized with video, you can convert the transcript text to a video segment 
and save it. You can create a single video segment from a single annotation or create multiple video 
segments from an Annotations report. 

CREATING A VIDEO SEGMENT FROM A SINGLE ANNOTATION 
To create a single video segment from an annotation, complete these steps: 

1. Double-click an annotation in the left pane. The highlighted text of the annotation is displayed in 
the right pane. 

2. Right-click in the annotation, point to Send on the menu, then click Video File. The Save As dialog 
box is displayed.

3. Click a location for the file. 

4. In the File name box, type a different file name, if desired.

5. Click Save. The message Would you like to view the new video clip now? is displayed. 

6. Click Yes to view the video segment. 

CREATING MULTIPLE VIDEO SEGMENTS FROM AN ANNOTATIONS REPORT
To create multiple video segments from an Annotations report, complete these steps: 

1. In the left pane, right-click the Annotations folder, then click Report. The Annotations report is 
displayed on the Report tab in the right pane.

2. Click Send at the top of the report, then click Video File on the menu. The Save As dialog box is 
displayed. 

3. Click a location for the file.

4. In the File name box, type a different file name, if desired.

5. Click Save. The message Video files saved successfully. Would you like to open the containing 
folder now? is displayed. 

6. Click Yes to open the folder in which the video segments are stored. The page and line ranges are 
added to the video segments. 
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EDITING VIDEO SEGMENTS
To edit the start and end time for a video segment that is associated with an annotation, right-click in 
the annotation and click Edit Annotation on the menu. The Annotations Properties dialog box is 
displayed. Click the Video tab, make your changes in the appropriate boxes, then click OK (Figure 21-1).

Figure 21-1. Annotations Properties–Video tab

Transferring Annotations to Microsoft PowerPoint 
You can transfer annotations and video segments to Microsoft PowerPoint and have them embedded in 
PowerPoint slides. Each annotation creates a separate slide. You can create a slide from a single 
annotation or multiple slides from an Annotations report. 

Note It is recommended that you use short annotations for each PowerPoint slide. If you need a longer 
excerpt, transfer multiple annotations from a report to create a single PowerPoint presentation 
with a slide for each annotation. 

Also, when you transfer annotations to PowerPoint from transcripts with associated videos, you have 
the option of saving both the PowerPoint file (PPT) and the video clip (WMV). If you want to share the 
PowerPoint presentation with someone else, you must include the associated WMV file for the 
embedded video to play. 

CREATING A POWERPOINT PRESENTATION FROM A SINGLE ANNOTATION 
To create a PowerPoint presentation from an annotation, complete these steps: 

1. Double-click an annotation in the left pane. The highlighted text of the annotation is displayed in 
the right pane. 

2. Right-click in the annotation, point to Send on the menu, then click PowerPoint. The Save As 
dialog box is displayed. 

3. Select a location for the file.

4. In the File name box, type a different file name, if desired. 

5. Click Save. The message Would you like to open the presentation now? is displayed. 

6. Click Yes to view the PowerPoint presentation. To create another PowerPoint presentation, close 
PowerPoint. 

CREATING A POWERPOINT PRESENTATION FROM AN ANNOTATIONS REPORT 
To create a PowerPoint presentation from an Annotations report, complete these steps: 

1. In the left pane, right-click the Annotations folder, then click Report. The Annotations report is 
displayed on the Report tab in the right pane. 
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2. Click Send at the top of the report, then click PowerPoint on the menu. The Save As dialog box is 
displayed. 

3. Click a location for the file.

4. In the File name box, type a different name for the file, if desired.

5. Click Save. The message Would you like to open the presentation now? is displayed. 

6. Click Yes to view the PowerPoint presentation. To create another PowerPoint presentation, close 
PowerPoint. 

SAVING POWERPOINT FILES WITH THE SAME NAME 
If you save a PowerPoint file with a name that already exists, the Existing PowerPoint File dialog box is 
displayed. Click Append slides to existing presentation to add slides to the existing presentation.
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Appendix

Using Issues to Create an Errata Report
The deponent has the option of reviewing the transcript after the deposition. If the deponent finds 
errors in the transcript, you can easily mark those places in the transcript and create an Errata report. To 
create an Errata report, complete these steps: 

1. Create an issue named Errata (see ”Working with Issues” on page 86) and add it to the Main Menu 
toolbar.

2. Make certain the Annotate Mode button ( ) is displayed on the toolbar above the transcript in 
the right pane. 

3. Click the Errata button on the Main Menu toolbar. 

4. Select the text in the transcript that the deponent reports is in error. The Annotation Properties 
dialog box is displayed. 

5. Type any information regarding the error in the Note box, e.g., Witness says name should be Joan, 
not John. Click OK. 

6. Right-click the Annotations folder under the transcript in the left pane and click Report. The report 
is listed under Report in the left pane and the text of the report is displayed on the Report tab in 
the right pane. 

7. Click the Properties button ( ) on the toolbar above the report to display the All 
Annotations Report Properties dialog box. 

8. On the Issues tab, clear all check boxes except the Errata check box.

9. Select the Only include Annotations with all selected issues (“Match all Issues”) check box.

10. Click OK. The report is redisplayed on the Report tab in the right pane with only the Errata 
annotations. 
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Converting RealLegal Binder Cases to Case Notebook Cases
When you open a RealLegal Binder case in Case Notebook, the properties for the case may or may not be 
converted. The following chart describes how the RealLegal Binder case properties are converted.

ITEMS THAT ARE CONVERTED ITEMS THAT ARE NOT CONVERTED

Transcripts Transcripts

• transcript text • transcript properties: Time, Plaintiff, 
Defendant

• transcript properties: Type, Status, Last, 
First, Volume, Date, Title, Taking Attorney, 
For, Comment

• links to documents from transcripts

• signature for signed transcripts 
(version 7.0 and later)

• video sync information

Documents Documents

• document contents • document properties: Title

• document properties: Type, Author, 
Recipient, Bates Range, Date, OCR 
information

• exhibit check box data, exhibit number, 
exhibit prefix

Annotations Annotations

• all annotations • chronology date

• issues, including name and color • active issue properties

• attachment URLs are preserved

• comments converted to notes

• annotations authors only converted when 
imported into a secure case

Search groups Search groups

• search groups converted to data groups

• search group name converted to data group 
title

• transcripts and documents from the search 
group converted to data group

• preprogrammed search groups that come 
with RealLegal Binder

• saved reports
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Prompts and Messages for Video and PowerPoint
You may receive the following warnings and error messages when transferring files as video or to 
PowerPoint. 

The file [PowerPoint file name] already exists. Do you want to append slides to existing presentation 
[or] overwrite existing file? 

In most cases you will want to append or add slides to the existing PowerPoint presentation. Refer to 
”Transferring Annotations to Microsoft PowerPoint” on page 119 for more information. 

The file is open in PowerPoint. Please close PowerPoint and retry. 

PowerPoint needs to be closed when you are creating a presentation or appending slides to an existing 
presentation. 

The folder already contains file named [video file name]. Would you like to replace this file? 

This error usually occurs when you try to transfer the same annotation twice or when you try to save over 
an existing PowerPoint presentation. If you do not want to replace the file, you can cancel the transfer 
and review the annotation to make sure nothing has changed and then resave the file, or you can save 
the file to a different folder. 

Synchronized video is not associated with this transcript. 

The video has not been synchronized with the transcript. A synchronized video is a video that plays in 
sync with the transcript; i.e., as the person in the video speaks, the transcript scrolls and highlights the 
spoken text. A utility (e.g., RealLegal Publisher) must be used to synchronize the video with the 
transcript; otherwise, the video plays but the transcript does not scroll. 

Video does not exist for this transcript. 

No video is associated with the transcript. You can transfer an annotation to PowerPoint, but not video. 

Cannot create clip from annotation that spans more than one file. 

This is a catchall error message designed for unsupported scenarios. Please contact Customer 
Technical Support at 1-800-290-9378 and describe what you were doing when this error occurred. 

Video clips can only be created from MPEG and WMV video files. 

Case Notebook only supports specific types of video files. For example, you cannot create video clips 
from RM (Real) or AVI (Audio Video Interleave) files. 

Failed to create temporary PowerPoint template file! Error code %d. 

This error may occur when your hard drive is full or if you do not have access rights to the hard drive 
where you are attempting to transfer the file. 

In order to create PowerPoint slides, you must first install PowerPoint on this computer. 

PowerPoint must be installed before you can transfer annotations to PowerPoint. 
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Connecting to a Simulated LiveNote Realtime Transcript
When Case Notebook is installed, it provides you with a demonstration case, which includes sample 
deposition transcripts, exhibits, preset issues, and simulation of a real-time deposition. You can use the 
simulated transcript to practice using the basic tools of Case Notebook. 

To access the simulation, complete these steps: 

1.  Access Case Notebook. 

2. When the Open Case dialog box is displayed, select Gil Bower v. DC Corporation and click OK. The 
case window is displayed. 

3. On the Main Menu toolbar, click the New arrow, then click Realtime Transcript on the menu. The 
Connect to Realtime dialog box is displayed.

4.  Select Simulation, then click Connect. The deposition automatically begins transcribing in the 
right pane.

Note The transcript is titled Realtime by default and listed under Transcripts in the left pane. To 
change the title of the transcript, right-click it and click Properties on the menu. The Transcript 
Properties dialog box is displayed. Click the Details tab and type a different title for the transcript 
in the Title box, then click OK.
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Trial Version of Case Notebook
Case Notebook offers a trial version of its software that includes the functionality of Case Notebook. In 
the trial version, you can

• connect to 15 Realtime sessions

• add up to three transcripts, 10 documents, five pleadings, 10 research files, 25 key facts, and 10 
characters

• create Issue Marks, Quick Marks, and annotations

• use the Word Index, Auto Tags, and Full Text Search (not available for some file formats added to 
the trial version)

• insert exhibits, transcript questions, and Westlaw documents into an outline

• send key facts to West Case Timeline, Microsoft Word, or Corel WordPerfect

• generate reports

In the trial version, you cannot

• update transcripts, documents, pleadings, and research files

• create outlines

• delete any items from the demonstration case

• save transcripts as ASCII files

• create a new case

• close the current case and open another case

• export cases

• connect to the Westlaw Case Notebook Repository

Notes

• A transcript printed from the trial version includes a Demo watermark.

• Optical character recognition (OCR) technology is not available in the trial version of Case 
Notebook.
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